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POLAR BODYAGE SYSTEM SW HELP 

About the Polar BodyAge System 

About the BodyAge Score 

The BodyAge score is an integral part of the Polar BodyAge® System and software developed by 
Polar. The instruments used to calculate the BodyAge score are validated and published in their 
respective fields and are listed on the following pages.  All normative and percentile ranking 
references are listed in the technical references. BodyAge simplifies fitness test results into one 
number that the non-professional can understand.  Using BodyAge has been shown to increase 
motivation levels of clients and increase exercise compliance. 

Calculation of BodyAge 

The BodyAge calculation is based on a population of 6,469 apparently healthy 18-79 year-old 
men and women.  Low levels of cardiovascular fitness and elevated blood pressure levels have 
been shown to increase the risk of premature death; therefore, they are weighted more heavily in 
the calculation.  This results in more years being added or taken away from the BodyAge score 
depending on each test result. Assessments that affect quality of life rather than longevity, such 
as flexibility and strength, are weighted slightly less. A minimum of four assessments must be 
taken in order to calculate BodyAge. Two of the four assessments must be strength, flexibility, 
cardiovascular or body composition assessments.  The other two can be any of the other 
assessments: systolic blood pressure, diastolic blood pressure, total cholesterol, HDL, body 
composition, cardiovascular, flexibility or strength.   

The Polar BodyAge in the Unites States 

Since its introduction in 2001, Polar BodyAge® System has been implemented and adopted by 
over 900 health and fitness centers, major universities and corporations in the United States.  A 
partial list of customers include: United Parcel Service (UPS), United States Air Force, 
Department of Education, Department of Defense, PGA West, Ford Motor Company, Gold’s 
Gym, Wal-Mart, US Marines, Boeing International, YMCA, Lifetime Fitness, Pepperdine 
University and Florida State University. 

The Polar BodyAge System in Europe 

The Polar BodyAge® System was released in Germany under the name Polar OwnTestTM  System 
in 2004. Before that time a pilot study was done by a German based research organization, LINK 
Institute, to evaluate the effectiveness of the system in the European market.  An overview of the 
study design, results and conclusions are listed below. 

Target and Study Design 
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• The target of the study was to evaluate the use and feasibility of the BodyAge system as well as 
validity of measurements by collecting the feedback from clients of the pilot clubs. 

• The pilot was carried out in three fitness clubs in Germany. 

• Each club provided a BodyAge system pilot test battery and feedback for a minimum of 50 
typical club members with a pre-test and post-test, minimum five weeks between tests. 

• After taking part in the assessment, each participant received a questionnaire (Q1) and after the 
retest they received a second questionnaire (Q2). 

• The instructors received a questionnaire at the end of the pilot (T). 

Test Battery of Pilot Project 

• PAR-Q 

• Medical Questionnaire 

• Weight and Height for BMI 

• Body Composition (skinfold or bioimpedance) 

• Polar OwnIndex® for V02MAX

• Polar OwnZone®

• Crunch Test 

• Biceps Strength Test 

• Wall Sit Test 

• Sit and Reach Test 

Results: Club Members 

• 90% of club members believe that the BodyAge assessment is important.   

• 80% of members believe going through the BodyAge system is rather easy (not difficult). 

• 76% of the club members think the reports are very useful (6 on a 6 point scale) and 86% 
believe it is well presented. 

• 81% of the members felt that the BodyAge Score was motivation for further training. 

2 
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• In 7 out of the 8 tests, all the people on average improved their results from the first test to the 
second test. This supports the results that the members felt that the BodyAge system and 
BodyAge Score motivate for further exercise training. 

Results: Instructors 

• The instructors judge the importance of the BodyAge system as high and the difficulty as low. 

• The reports are judged as useful and no additional materials are needed in the reports. 

• On average the instructors suggest they need 41 minutes to conduct the test. 

• The instructors agree with the club members that the BodyAge is a very meaningful parameter. 

• The instructors feel a high increase of quality of work, a high support in motivating clients and a 
high support in communicating heart rate controlled training. 

Polar BodyAge System Declaration of Conformity 

The Polar BodyAge® System (AKA Model TriFIT 700) is tested under the EU Medical Device 
Directive –93/42/ECC.   A Class 1 Electrical Medical Device Type BF Protection.  Testing 
standards used are the EN 60601 – Safety of Electrical Medical Equipment.  The Polar 
BodyAge® System (AKA Model TriFIT 700) bears the CE MARK as verified by investigation by 
the EU Notified Body, TUV Rheinland.   

The Polar BodyAge® System (AKA Model TriFIT 700) Product complies with the RoHS Directive 
 2002/95/EC and WEEE Directive 2002/96/EC mandatory as of July 1st, 2006. 

Technical References 

Biometrics 

PAR-Q 

Canadian Society for Exercise Physiology (revised 1994) 

Height / Weight and BMI Adults 

American College of Sports Medicine Guidelines for Exercise Testing and Prescription. 
 7th Edition (2006) 

Clinical Guidelines on the Identification, Evaluation, Treatment of Overweight and Obesity 
in Adults:  Evidence Report developed by the NHLBI Expert Panel (1998) 
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National Center for Health Statistics in collaboration with the National Center for Chronic 
Disease Prevention and Health Promotion, May 30, 2000. 
 http://www.cdc.gov/growthcharts. 

Blood Pressure 

Practice Guidelines for Primary Care Physicians: 2003 European Society of 
Hypertension/European Society of Cardiology, Journal of Hypertension 2003; 21: 1011-
1053 

Seventh Report on the Joint Committee on Detection, Evaluation, and Treatment of High 
Blood Pressure (JNCB), Hypertension. 2003 Dec;42(6):1206-52 

McArdle, William D., Frank I. Katch, and Victor L. Katch, Exercise Physiology:  Energy, 
Nutrition, And Human Performance, Malvern, PA:  Lea & Febiger publisher, 1991 

Polar measures blood pressure on the right arm based on the following references.  Reasons to 
use the right arm include the remote possibility that the genetic anomaly of coarctation (abnormal 
narrowing) between the aorta and subclavian artery will cause an elevated blood pressure.  If the 
pressure in the right arm is normal, it is likely to be normal everywhere.  

1. Burch, G.E. (1976). Consultations in Hypertension: A Clinical Synposium. Rochester, 
NY: Pennwalt Prescription Products. 

2. Task Force on Blood Pressure Control in Children.  (1977).  Report of the Task Force on 
Blood Pressure Control in Children.  Pediactrics 59 (Suppl.), 797-820. 

Cholesterol (Total, LDL,HDL,LDL/HDL Ratio) 

Executive summary of the third report of the National Cholesterol Education Program (NCEP) 
Expert Panel on Detection, Evaluation, and Treatment of High Blood Cholesterol in Adults (Adult 
Treatment Panel III). JAMA 2001; 285:2486-97.  

Ratio Reference 

Cooper, Kenneth H. Controlling Cholesterol. The Cooper Institute, 1985, pg 65.   

Glucose Norms 

American College of Sports Medicine Guidelines for Exercise Testing and Prescription.  7th 
Edition, pg. 47 (2006) 

Girth Measurements (Waist to Hip Ratio) 
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American College of Sports Medicine Guidelines for Exercise Testing and Prescription.  7th 
Edition, pg. 58 (2006) 

Body Composition  

Body Composition Norms (3-Site and 7-Site Adult Skinfold Protocols) 

Hoeger & Hoeger (1991).  Principles and Labs for Physical Fitness and Wellness, p. 90.  ** we 
changed the classifications from Excellent/Good/Moderate/Overweight/Obese to 
Low/Optimal/Moderate/High/Very High. 

Adding 1.9% for black males and 1% for black females reference:  Lohman and Heyward, (1989), 
Advanced Fitness Assessment and Exercise Prescription, page 148. 

Body Composition Percentile Rankings (3-Site and 7-Site Skinfold Protocols) 

American College of Sports Medicine Guidelines for Exercise Testing and Prescription.  7th 
Edition, (2006) 

Cooper Institute for Aerobics Research, Dallas TX (1994). 

Skinfold Site Descriptions 

American College of Sports Medicine Guidelines for Exercise Testing and Prescription.  7th 
Edition, (2006) 

3-Site Equation - Men and Women  

Jackson, A.S., Pollock, M.L. (1980). Medicine & Science in Sports and Exercise, 12, 175-18. 

Generalized Equation for Predicting Body Density of Women.   

Jackson, A.S., Pollock, M.L. &  Ward, A. (1980).  Generalized Equation for Predicting Body 
Density of Women.  Medicine & Science in Sports and Exercise, 12, 175-18. 

7-site Equation – Men and Women 

Jackson, A.S., Pollock, M.L.: Practical Assessment of Body Composition. Physician Sport 
Medicine 1:76-90, 1985. 

Generalized Equation for Predicting Body Density of Men 

Jackson, A.S., Pollock, M.L. (1978).  Generalized Equation for Predicting Body Density of Men. 
 British Journal of Nutrition, 40, 497-504. 
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Conversions of Body Density to Body Fat 

Lohman and Heyward, (1989) Advanced Fitness Assessment and Exercise Prescription, page 
148. Ages 7 to 50+ Years of Age using a multicomponent model that takes into account Age, 
Gender, Fat Free Body density (changed based on differences in body water & bone mineral in 
different age groups). 

BioImpedence guidelines and information  

Tanita Body Composition Analyzer BF-350 Instruction Manual and Techincal Notes 

Impedance Equations (for Manual Entry) 

Lohman, T.G. (1989, Feb.)  Bioelectrical Impedance Analysis Seminar presented to Department 
of Exercise Science, University of Arizona, Tucson. 

Lukask, H.C., Johnson, P.E., Bolonchuck, W.W., & Lyken , G.I. (1985).  Assessment of Fat Free 
Mass using Bioelectrical Impedance Measurements of the Human Body. American Journal of 
Clinical Nutrition, 41, 810-917. 

Circumference Protocols 

Tran, Z.V., & Weltman, A. (1989).  Generalized Equation for Predicting Body Density of Women 
from Girth Measurements. Medicine & Science in Sports and Exercise, 21, 101-104. 

Behnke, A.R., & Wilmore, J.H. (1974).  Evaluation and Regulation of Body Build and 
Composition. Englewood Cliffs, NJ: Prentice-Hall. 

Low Body Fat  

Exercise Physiology: Energy, Nutrition, And Human Performance, Philadelphia, PA:  Lippincott 
Williams & Wilkins, 2001 

Cardiovascular  

Polar OwnIndex®  

Jackson, Blair, Mahar, Ross and Stuteville.  Prediction of functional aerobic capacity without 
exercise testing.  Med Sci Sports Exerc 22, 6, 863-870, 1990.  

Väinämö, Tulppo, Mäkikallio, Röning. An artificial neural network for human aerobic fitness 
approximation.  Proceeding of the International Neural Network ICNN, Washington DC, June 3-6, 
1996, pp. 1939-1949. 
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Laukkanen, Kinnunen, Kiuru.  Polar Fitness Test-a new era in Cardiovascular Fitness Testing. 
 Polar Electro Oy, Finland  

OwnZone®  

American College of Sports Medicine. Position Stand: The recommended quantity and quality of 
exercise for developing and maintaining cardiorespiratory and muscular fitness, and flexibility in 
healthy adults. Med Sci Sports Exerc 30(6), 975-991, 1998.  

Byrne N, Hills A, Ramage A, Laukkanen R. Use of heart rate variability (HRV) in prescribing 
exercise intensity threshold in the obese. Int J Obes 23(5):567, 1999.  

Huikuri H, Seppänen T, Koistinen J, Airaksinen J, Ikäheimo M, Castellanos A, Myerberg R. 
Abnormalities in beat-to-beat dynamics of heart rate before the spontaneous onset of life-
threatening ventricular tachyarrhythmias in patients with prior myocardial infarction. Circulation 
93, 1836-1844, 1996.  

Kinnunen H, Tulppo M, Mäkikallio T, Hyyppä O, Nissilä S, Laukkanen R. Reproducibility of 
individual training heart rate determined by Polar SmartEdge heart rate monitor. Proceedings of 
the International Puijo Symposium, Kuopio, Finland, p. 63, 1998.  

Laukkanen R, Maijanen S, Tulppo M. Determination of heart rates for training using Polar 
SmartEdge heart rate monitor. Med Sci Sports Exerc 30(5), 1430, 1998.  

Mäkikallio T, Tulppo M, Karppinen T, Huikuri H. Nonlinear complexity of heart rate dynamics after 
a resting period followed by endurance training. ACSM Annual Meeting 1996. Med Sci Sports 
Exerc 28(5), 745, 1996.  

Thompson R, Wilkinson J, Laukkanen R, Seppänen T. The relationship of short-term measures of 
hrv to heart rate and exercise intensity. Med Sci Sports Exerc 29(5), 795, 1997.  

Tulppo M, Mäkikallio T, Airaksinen J, Huikuri H. Nonlinear dynamics of heart rate during 
accentuated sympatho-vagal interaction. Circulation 94(8), nr. 2518, 1996a.  

Tulppo M, Mäkikallio T, Takala T, Seppänen T, Huikuri H. Quantitative beat-to-beat analysis of 
heart rate dynamics during exercise. Am J Physiol 271, H244-252, 1996b.  

Tulppo M, Mäkikallio T, Seppänen T, Thomson R, Wilkinson J, Blair S, Laukkanen R, Huikuri H. 
Non-linear dynamics of heart rate variability during exercise. ACSM Annual Meeting 1996. Med 
Sci Sports Exerc 28(5), 142, 1996c.  

Tulppo M, Mäkikallio T, Seppänen T, Laukkanen R, Huikuri H. Vagal modulation of heart rate 
during exercise: effects of age and physical fitness. Med Sci Sports Exerc 29(5), nr. 814, 1997a.  
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Tulppo M, Mäkikallio T, Seppänen T, Laukkanen R, Huikuri H. Vagal modulation of heart rate 
during exercise: effect of age and physical fitness. Eur Heart J 18, p. 114, 1997b.  

Tulppo M, Mäkikallio T, Seppänen T, Laukkanen R, Huikuri H. Vagal modulation of heart rate 
during exercise: effects of age and physical fitness. Am J Physiol 274 (Heart Circ. Physiol. 43), 
H424-H429, 1998a.  

Tulppo M. Heart rate dynamics during physical exercise and during pharmacological modulation 
of autonomic tone. Doctoral Dissertation. Acta Universitatis Ouluensis D 503, Oulu, Finland, 
1998b.  

Tulppo M, Mäkikallio T, Laukkanen R, Huikuri H. Differences in autonomic modulation of heart 
rate during arm and leg exercise. Clin Physiol 19(4), 294-299, 1999.  

Wilkinson J, Thompson R, Garcia M, Kampert J, Laukkanen R, Seppänen T. The relationship of 
Poincaré Plot analysis to exercise intensity. The International Pre-Olympic Scientific Congress, 
July 1996, Dallas, Texas, USA. Abstracts. p. 115-116. 1996a.  

Wilkinson J, Thompson R, Garcia M, Kampert J, Laukkanen R, Seppänen T. The response of 
heart rate variability during graded treadmill exercise. Circulation 94(8), nr. 1465, 1996b.  

Wilkinson J, Thompson R, Garcia M, Kampert J, Laukkanen R, Seppänen T. The relationship of 
heart rate variability to work intensity during graded maximal treadmill exercise. International 14th 
Puijo Symposium, June 1996, Finland. Proceedings. Kuopio University publications D. Medical 
Sciences 101, p. 64, 1996c.  

Wilkinson J, Thompson R, Seppänen T, Laukkanen R. Heart rate variability and cardiorespiratory 
fitness. Med Sci Sports Exerc 29(Suppl 5), 850, 1997.  

Virtanen P, Vasankari T, Vuorimaa T, Laukkanen R. Evaluation of the Polar OwnZone feature in 
physically highly active men and women. Proc 5th Annual Congress of ECSS, Jyväskylä, Finland, 
19-23 July 2000. 

Virtanen P, Vasankari T, Vuorimaa T, Laukkanen R. HRV plateau in exercise intensity 
determination in endurance athletes. Med Sci Sports Exerc 33(5), nr 611, 2001. 

PAR Questionnaire (used to determine Watts used in protocol) Jackson AS, Blair SN, Mahar MT, 
Wier LT, Ross RM, Stuteville JE. Prediction of functional aerobic capacity without exercise 
testing. Med Sci Sports Exerc 1990; 22(6): 863-870. 

WHO Bike Ergometer VO2MAX Estimation 

Lange  Andersen,  K.,  Shephard,  R.J.,  Denolin,  H.,  E. Varnauskas, and R. Masironi. 
Fundamentals of exercise testing. Geneva: WHO,1971  

8 



Polar BodyAge System SW Help 

Basis for Fitness Testing (Kuntotestauksen perusteet), Liite ry, Helsinki, Finland, 1998. 

Shvartz E, Reibold RC: Aerobic fitness norms for males and females aged 6 to 75 years: a 
review. Aviat Space Environ Med; 61:3-11, 1990. 

PAR Questionnaire (used to determine Watts used in protocol) Jackson AS, Blair SN, Mahar MT, 
Wier LT, Ross RM, Stuteville JE. Prediction of functional aerobic capacity without exercise 
testing. Med Sci Sports Exerc 1990; 22(6): 863-870. 

Adult VO2max Norms/Classifications 

Shvartz E, Reibold RC: Aerobic fitness norms for males and females aged 6 to 75 years: a 
review. Aviat Space Environ Med; 61:3-11, 1990. 

Adult VO2mac Percentile Rankings 

The Physical Fitness Specialist Certification Manual, The Cooper Institute for Aerobics Research, 
Dallas, TX, revised 1997.   

YMCA Bike Ergometer 

Golding, L.A., Myers, C.R., and Sinning, W.E. (1989).  Y’s Way to Physical Fitness (p.91). 
 Champaign, IL: Human Kinetics Publisher. 

Pollock Bike Ergometer 

Pollock, M.L., Wilmore, J.H., & Fox, S.M., III. (1978).  Health and Fitness Through Physical 
Activity. (p.304). New York: Wiley. 

Bruce Treadmill Protocol and Modified Bruce Treadmill Protocol 

Bruce, R.A., Kusumi, F., & Hosmer, D. (1973).  Maximal Oxygen Intake and Nomographic 
Assessment of Functional Aerobic Impairment in Cardiovascular Disease. American Heart 
Journal, 85, 546-562. 

Rockport One Mile Walk 

Rockport Walking Institution, (1986) Kline et al. 1987, McSwegin et al. 1998 

Cooper 12minute Run 

Cooper, 1968 

Three Minute Step Test 
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Golding, L.A. (2000). YMCA Fitness testing and Assessment Manual. Chanmpaign, IL: Human 
Kinetics Publsiher 

Strength 

Biceps Strength Test 

Badger, D.W. (1988).  Work Practices Guide for Manual Lifting.  National Institute for 
Occupational Safety and Health, 81-122 

Chaffin, D.B., Herren, G.D., Keysterling, W.M. Pre-employment Strength Testing – An Updated 
Position.  Journal of Occupational Medicine, Vol. 20, No. 6, June 1978. 

Gallagher, S., Moore, J.S., Stobbe, T.J., Physical Strength Assessment in Ergonomics.  American 
Industrial Hygiene Association, 1998. 

Hand Grip Protocol 

Devries, H.A. (1980) Physiology of Exercise for Physical Education and Athletes. WCB, Dubuque, 
Iowa Promotion. 

Adams, G.M. (1980) Exercise Physiology Lab Manual, WCB, Dubuque, Iowa. 

Hand Grip Norms 

Corbin, C.B., Dowell, L.J., Lindsey, R., Tolsen, H. (1978).  Concepts in Physical Education, WCB, 
Dubuque, Iowa 

60 Second Crunch Test                                                                                                                

Golding, Lawrence A. (2000). YMCA Fitness Testing and Assessment Manual (Fourth Edition). 
Champaign, IL: Human Kinetics Publishers.  

Jette, M., Sidney, K., & Cicutti, N. (1984). A critical analysis of sit-ups: A case for the partial curl-
up as a test of abdominal muscular endurance.  Canadian Association for Health, Physical 
Education & Recreation, 51(1), 4-9. 

Diener, M.H., Golding, L.A., Diener, D., Validity and Reliability of a One-Minute Half Sit-up Test of 
Abdominal Strength and Endurance. Sports Med., Training and Rehab., Vol. 6, pp.105-119, 1995. 

90˚ Wall Sit test  

Griffiths, P., Hughes, G.I., and Moffett, J.A.K. (1993).  A Longitudinal Study of Low Back Pain in 
Student Nurses. Int. J. Nurs. Stud., Vol. 30, No. 3, pp. 197-212.  
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Calisthenics Norms 

Pollock, M.L., Wilmore, J.H., & Fox, S.M., III, (1978).  Health and Fitness Through Physical 
Activity (p. 109 & 110).  New York:  Wiley. 

1-RM Protocol and Norms 

The Cooper Institute for Aerobics research:  The Physical Fitness Specialist Certification Manual. 
Dallas, TX (revised 1997).  

Flexibility 

Modified Sit & Reach  

Wear, C.L. (1963) The Relationship of Flexibility Measures to Length of Body Segments.  Res 
Quarterly, 34, 234-238. 

Flexibility Norms (all protocols) 

Hoeger, W.W.K. (1989).  Lifetime Physical Fitness and Wellness (p.84).  Englewood, CO: 
 Morton. 

Lemmink, K., Kemper, H., deGreef, M. Rispens, P., Stevens, M. The Validity of the Sit and Reach 
Test and the Modified Sit and Reach Test in Middle-Aged to Older Men and Women.  Research 
quarterly for Exercise and Sport. Vol. 74, No. 3, PP. 331-336 (2003) 

Supporting References for the BodyAgeTM Calculation  

van den Hoogen PC, Feskens EJ, Nagelkerke NJ, Menotti A, Nissinen A, Kromhout D. The 
relation between blood pressure and mortality due to coronary heart disease among men in 
different parts of the world: Seven Countries Study Research Group. N Engl J Med. 2000;342:1–
8. 

MacMahon S. Blood pressure and the risk for cardiovascular disease. N Engl J Med. 
2000;342:50–52. 

Izzo JL Jr, Levy D, Black HR. Clinical advisory statement: importance of systolic blood pressure 
in older Americans. Hypertension. 2000;35:1021–1024. 

Franklin SS, Gustin W 4th, Wong ND, Larson MG, Weber MA, Kannel WB, Levy D. 
Hemodynamic patterns of age-related changes in blood pressure: the Framingham Heart Study. 
Circulation. 1997;96:308–315. 

Bilato C, Crow MT. Atherosclerosis and vascular biology of aging. Aging. 1996;8:221–234. 
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Benetos A, Rudnichi A, Safar M, Guize L. Pulse pressure and cardiovascular mortality in 
normotensive and hypertensive subjects. Hypertension. 1998;32:560–556. 

 Lee IM; Hsieh CC; Paffenbarger RS. Exercise intensity and longevity in men. JAMA 1995 Apr 
19;273(15) :1179-84.  

 Lissner L, et al. Physical activity levels and changes in relation to longevity. A prospective study 
of Swedish women. Am J Epidemiol 1996 Jan 1:143(1) :54-62. Sherman SE, et al. Does exercise 
reduce mortality rates in the elderly? Experience from the Framingham Heart Study. Am Heart J 
1994 Nov:128(5) :965-72. Sherman SE, et al. Physical activity and mortality in women in the 
Framingham Heart Study. Am Heart J 1994 Nov:128(5) :879-84.  

Paffenbarger RS, et al. The association of changes in physical-activity level and other lifestyle 
characteristics with mortality among men. N Engl J Med 1993 Feb 25;328(8) :538-45.  

Thompson WG. Exercise and health: fact or hype? South Med J 1994 May;87(5) :567-74.  

Weyerer S, et al. Physical exercise and psychological health. Sports Med 1994 Feb:17(2) :108-
16.  

Pate R, et al. Physical activity and public health. JAMA Feb. 1, 1995 pp. 402- 407.  

Fiatarone MA, et al. Exercise training and nutritional supplementation for physical frailty in very 
elderly people. N Eng J Med 1994 Jun 23;330(25) :1769-75.  

Health Risk Appraisals 

Heart Disease 

American Heart Association, RISKO A Heart Health Appraisal, 1994. 

Depression 

Beck, Aaron T., Steer, Robert A., Beck Depression Inventory, The Psychological Corporation, 
1993. 

Nutrition 
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The Surgeon General’s Report on Nutrition and Health; USDHHS, PHS, Washington, D.C., 1988 
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Prevention and Safety 

Vital Statistics of the United States, 1988 

American Medical Association (AMA) Family Medical Guide, Random House, Inc. revised edition, 
1987 

Diabetes 

American Diabetes Association, Sound the Alert!, 1995 

Stress 

Spielberger, Charles D., State – Trait anxiety Inventory. Consulting Psychologists Press, Inc. 
 1984 

Cancer 

American Cancer Society, Cancer: Assessing Your Risk, 1993.  

Setting up the Polar BodyAge System 

Requirements and Recommendations 

The Polar BodyAge® System is designed to gather, process, interpret and display fitness and 
wellness data. The Polar BodyAge® System is designed to be used by exercise professionals. 

These items are necessary to operate the Polar BodyAge® System:  

• 220 Volt Power outlet highly recommended to be a dedicated line. A dedicated line is 
where only one circuit is servicing the outlet. (European) 

• 110 volt power outlet highly recommended to be a dedicated line.  A dedicated line is 
where only one circuit is servicing the outlet. (U.S.) 

These items are recommended: 

• Private/quiet environment for fitness testing 

• Cool temperature (72°F, 22°C), moderate humidity and good air circulation (fan 
recommended for bike & treadmill testing). 

• Telephone with outside line for emergency access and technical support. 
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• Flat, firm surface for the platform/scale. 

Unpacking the Polar BodyAge System 

Once the system is out of the shipping container and on the floor: 

• Remove all packing materials 

• Move the scale and any boxes off of the cart 

• Mount the monitor onto the main post, being careful not to pinch any of the cables (see photo) 

 

 

 

 

Packing List 

The following is a list of all the items included with your system. These are standard items 
included with every system.  You may have other items as part of your individual order. 

1. Polar heart rate transmitter and elastic strap 

2. Strength handle and strength strap assembly 

3. On-line Skyndex Skinfold calipers w/calibration dowel  

4. Flat Panel LCD monitor w/speakers 

4. Computer 

5. Keyboard 
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6. Mouse 

7. Printer 

8. Power cord attached for the cart power 

9. BodyAge System computer installed in the cart (if ordered) 

10. BodyAge System cart with integrated range of motion (ROM) unit 

11. WindLinkTM Heart rate receiver  

12. Platform/scale  

13. 2 Allen wrenches for assembly/repair. 

14. Polar BodyAge® System software 

15. Blood Pressure included with 3 cuffs. 

16. Polar FlowLink 

 

 

Compatible Hardware 

• Tanita BF-350 Bioimpedance Unit 

• Tanita BC-418 Bioimpedence Unit (European) 

• Monark Bike  

• Magnum Bike and Trackmaster Treadmill 

• Ergofit Ergometers: cycle 3000 med (series), recumbent 3000 med (series), and circle 
3000 med (series). (European) 

Tanita Bioimpedance Unit  

The Tanita Bioimpedance unit interfaces with the Polar BodyAge® System to obtain body fat % 
and total body water. 

Tanita BF-350 
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Tanita BC-418 

 

Contact your Polar dealer for more information on where to purchase the Tanita BF-350 or BC-
418.  

Monark Bike 

If a Monark 828E was purchased with your system, you will receive a bike interface split cable. 
 This cable plugs into the interface unit where it is labeled with the heart and pedals icon. 
 Position the split end that holds the Polar receiver per the set up instructions included with the 
cable.  Refer to the instruction manual that came with the Monark 828 for assembly instructions. 
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Magnum Bike & Trackmaster Treadmill (U.S.) 

If a Magnum Upright bike was purchased with your system, you will receive a serial cable that 
plugs into the back of the computer. Go to Test Environment > Cardiovascular Settings and 
select Magnum and the correct serial port. For more information, see Cardiovascular Settings. 
The same steps apply for the TrackMaster Treadmill. 

 

ErgoFit Ergometer 

Contact your Polar dealer for more information on where to purchase the ErgoFit Ergometers. 
The Polar BodyAge® System is compatible with ErgoFit cycle 3000 med (series), ErgoFit 
recumbent 3000 med (series), and ErgoFit circle 3000 med (series). 
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Assembling the Polar BodyAge System 

Interface Connections 

Noting that the interface box is secured to the top of the computer with a velcro strip, connect the 
following peripherals to the box: 

Skinfold 
Calipers 

 

Platform 

 

Heart Rate 
Cable/RPM 
cable 
interface  

 

ROM 
(Range of 
Motion) 
Unit 

 

 

Printer 

Plug the power into the printer. 

Main Unit Power 

18 



Polar BodyAge System SW Help 

Using the main power cable, plug the system into a wall outlet.  Power is applied to the system 
via the power entry module located on the left rear of the cart. 

1. Plug power 
cable into a wall 
outlet. 

2. Always use 
the system main 
power switch to 
turn the entire 
system on and 
off.  On is “|” 
and off is “o”. 

 

Power Entry Module Information 

The power entry module is a switchable power supply between 110v (USA and Canada) and 
230v (European).  The unit is shipped from the factory with the 230v selected.   

Fuse Types:   

For the 110Volt (USA and Canada), the fuses are  ¼ x 1 ¼” 250Volt, 2 Amps, Slow Blow Fuses. 

For the 230Volt (European), the fuses are 5mm x 20mm, 250Volt, 3.0-3.5 Amp Slow Blow Fuses. 

Replacing the Fuses: 
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• To replace the fuses, make sure the power 
is unplugged and completely disconnected 
from the power.   

• Next, using a small flathead screwdriver, 
pry the cover open on the far right side. 

• Carefully pry the fuses out and insert the 
new fuses. 

• Close the cover, insert the power cord and 
turn the power switch on “|”. 

 

Platform/Scale 

• Screw in the eyebolt on 
the scale strap assembly 
into the top of the 
platform. Make sure it is 
tightened all the way. 

• Attach the “C” connector 
on the strength strap 
assembly to the strength 
handle. Make sure it is 
tightened all the way. 

• Check the strap for any 
wear or defects before 
each use, as this can 
cause injury to the client 
being tested on the 
biceps strength test.  

 

Ergofit Ergometer 

The ErgoFit bike needs to be connected to the Polar BodyAge® System with a null modem cable. 
 This cable plugs into the back bottom of the ErgoFit ergometer. Plug the other end of the serial 
cable into an available serial port in the back of the CPU. 

Note: The serial cable is a 9-pin null-modem Cable. You must use a null-modem cable or a null-
model adaptor for the Ergofit Ergometer to function properly with the Polar BodyAge® System. 
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1. Power cable for 
the Ergofit. 

2. Plug the null 
modem serial 
cable into the 
Ergofit serial plug. 

 

Tanita BF-350 or BC-418 

The Tanita BF-350 or BC-418 is a unit for measuring bioimpedance using the Polar BodyAge® 
System. It interfaces to the system with a serial cable.   

Note: The serial cable is a 9-pin null-modem cable. You must use a null-modem cable or a null-
model adaptor for the Tanita BF-350 to function properly with the system. 

Plug the 
power 
cord 
into a 
220v 
power 
outlet. 

Plug the 
serial 
cable 
into the 
Tanita 
BF-350 
or BC-
418 as 
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shown 
here. 

Plug the 
other 
end of 
the 
serial 
cable 
into 
Device 
Port 1 
or 
Device 
Port 2 
on the 
TF700iu 
box. 

 

Polar Sonic InterfaceTM

The optional Polar Sonic InterfaceTM uses the speaker and microphone ports on your PC to send 
and receive information to Polar training computers (F11, F6, F4 and all Polar UpLink enabled 
computers).   

 

Installation Instructions 

Plug the GREEN Polar Sonic 
Interface cable into the Speaker 
port on the computer. 

Alternately, This can be plugged 
into a headphone jack on the 
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computer 

Plug the PINK Sonic Interface 
cable into the Microphone port on 
the computer. 

 

If you want to use your existing speakers and microphone on your PC, use the included “Y” 
splitters. If you have your PC Speakers enabled using the “Y” Splitter, you will hear a sound from 
your PC speakers when setting the training computer. There is never sound when uploading files 
from the training computer to the PC. You will need to adjust the speaker and microphone volume 
for proper operation, depending on the noise of your environment and computer sound card type.  

1. To your 
microphone 

 

2. To your 
speakers 

 

 

Transporting the polar BodyAge System 

Before transporting your system: 

• Unplug the following peripherals: skinfold calipers, platform. Leave the bike cable plugged in; 
coil and store in the computer compartment. 

• Secure the central processing unit with foam or other materials such as wadded paper or bubble 
wrap to prevent shifting. 
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• Consider dismounting the monitor and wrapping with bubble wrap. 

• Secure the printer on its tray with an elastic cord around the top of the printer or use stretch 
wrap. 

• Avoid laying the system on its side.  The central processing unit is not secured with anything 
except the materials you place in the compartment.  If you must lay it down, make sure the CPU 
compartment opening is facing upwards. 

Preparations 

Recommendations for Operating Staff 

It is recommended that ALL OPERATORS have a basic understanding of Windows operating 
system.  If not, it is recommended that the primary operator take a course in the basic operation 
of Windows. 

Polar recommends that the operator of the Polar BodyAge® System be certified in CPR and hold 
a certification in fitness assessment or sports degree. 

Turning on The Polar BodyAge System Power 

1. Turn on the system main power switch located at the left side of the cart.  

 

2. When the power is applied to the unit, a green light appears in the interface box above the 
power indicator and you hear a start-up verification sound. 
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3. Turn on the central processing unit. 

4. Turn the power to the printer on. 

 

Setting up the Software settings 

To view and change the test environment settings for the BodyAge System, select System 
Settings > Test Environment. 

 

The following window appears: 
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In this window you can enter the settings below. Click on the name of a setting for instructions. 

General

Cardiovascular

Body Composition

Email Settings

Import/Export

Cardio 5 Zone

Other Programs

Calibrating On-line Peripherals 

When initially setting up your Polar BodyAge® System and each time the Polar BodyAge® 
System is transported or every two months, it is recommended to calibrate the skinfold calipers, 
the load platform (which calibrates both scale and biceps strength test) and the range of motion 
unit to ensure accurate results.  

Select System Settings > Calibrations. Select the Calibration Type from the drop-down box. 
You will be prompted with instructions regarding how to calibrate the equipment. For further 
instructions, see the following sections:   
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Calibrating the Skinfold Calipers

Calibrating the Load Platform

Calibrating the Range of Motion

  

Shutting Down the Polar BodyAge System 

Before turning off the power to the system, it is important to shut down the Polar BodyAge® 
System properly. 

1. Click the ”X” in the upper right corner, or go to File > Exit to exit the software. 

 

2. Turn off the computer. 

 

3. Now, turn off the power to the printer by pressing the printer power button located on the front 
panel of the printer. 
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4. Turn off the main power on the right side of the cart. 

 

 

Client Management 

Adding a New Client 

There are two ways to add a new client:  

Select File > New Client, or click on the  button in the upper left corner. 

The Client Information window appears. In this window you can enter the following information 
on your new client. 

1. General Information 
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The information that is shown in this window depends on your choices in System Settings > 
Test Environment > General > Client Information Options. For more information, see General 
Settings.  It is strongly suggested that you enter a unique identification code (up to 50 characters) 
for each client to organize your data. First Name, Last Name, Date of Birth and Gender are 
required fields.   

Click OK to save the client data and to return to the main view. 

Click Cancel to cancel adding a new client or making changes in the current client's information. 

2. Groups 
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To add a client to a group, highlight the group from the list of available groups and click +. 

To create a new group, click on the   button on the Available Groups field. The Customize 
window appears: 
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1. Click New to activate text field. 

 

2. Type in the name of the group.  

3. Select a parent group from the drop-down list. If you have not created groups before, the only 
option on the list is Club.  
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4. Click Save to save the group.  

5. Click Close to exit the Customize window.  

6. The group is now shown on the list of available groups and you can add the client to this group.  

Click OK to save the client information. 

You can enter Client Information afterwards by clicking the Client Information tab on the upper 
left corner of the main view. You will also have options to enter additional client information. For 
more information, see Client Information. 

Main Screen View - Client Information 

The View menu offers you a selection of useful features for managing client data. Check or 
uncheck the features to show or hide them on the main screen. 

 

For more information on the features, see the following sections:Notes, Alerts and Client 
Information

If all the features from the View menu are selected, they will appear on the main screen as 
follows: 

 

If you roll the mouse over any of the items above, then a roll-out screen with additional 
information appears. 
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If you move your mouse off of the roll out screen, it will roll back in.  

By clicking on the pushpin  in the upper right corner, the roll-out screen stays visible until you 
re-click on the pushpin.  

Notes 

Notes is a feature that allows you to add a comment about a particular day or session. For 
example, if your client was sick one day, you can make a note of it under the client's name with a 
date stamp.   

To enter Notes, roll your mouse over the Notes tab. The following roll down screen appears:  

 

Click the + icon to activate the text screen. When you are finished typing your note, click the X in 
the upper right corner of the notes screen. The note will be saved.   

 

To delete a note, use the mouse to highlight the text and hit backspace on the keyboard. 

Alerts 
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Alerts is a feature that informs you on any urgent medical information on a client. For example if 
your client has cardiovascular disease or is allergic to bee stings, you can make a note of it in 
Alerts so that in an emergency you can act accordingly.   

To enter Alerts, roll your mouse over the Alerts tab. The following roll down screen appears:  

 

If you click on the drop-down arrow you will see the two default alerts (Asthma and Diabetes).  

To add a new selection, click on the  button on the right of the drop-down box. 

The following window appears: 

 

1. Click New to activate text field. 

2. Type in the name of the alert.  

3. Click Save to save the alert.  
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4. Click on Close and the added alert will appear in the drop-down selection of the Alerts roll 
down screen. 

To add an alert, highlight it and click on the green plus (+) sign.  To erase an alert, highlight it (it 
will now appear in the large white text field) and click on the red minus(-) sign. 

 

Client Information 

To add or edit Client Information, roll your mouse over the Client Information tab. The 
following roll down screen appears:   

 

1. General Information 

In this view you can add or edit the client information that was initially entered in Client 
Information when the client was added to the system. The information that is shown in this 
window depends on your choices in Client Information Options in System Settings  > Test 
Environment > General Settings. For more information see General Settings.  

2. Address Information 

In this view you can add or edit the client's address information. 

3. Additional Information 

In this view you can add drop-down selections for the fields created in Preferences > Edit 
Additional Information (for more information, see Edit Additional Information).  For example if 
you want to know what is your client's sport, or if they follow a specific diet (i.e. vegetarian), you 
can make fields with a drop-down box of selections.   

For example, if you have added a field "Favorite sport" in Edit Additional Information, the field 
will be shown in Additional Client Information as shown below: 
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To add drop-down selections for the fields, click on the   button on the upper right corner. 

The following window appears. 

 

Click New to enable the text field and type the selection. 

If you select Save, the selection will appear in the larger box field. 

By clicking on New you start the process over again. 

By highlighting the selection, and selecting Edit, you can change the option. 

By clicking Close, the selections will appear on the drop-down list next to the question field. 
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4. Groups 

Add the client to a group by highlighting the group from the list of available groups. Click Add.  

 

To create a new group, click on the   button on the  Available Groups field. The following 
window appears: 

 

1. Click New to activate text field. 
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2. Type in the name of the group.  

3. Select a parent group from the drop-down list. If you have not created other groups before, the 
only option on the list is club.  

4. Click Save to save the group.  

5. Click Close to exit the Customize window.  

6. The group is now shown on the list of available groups and you can add the client to this group.  

 

Searching for a Client 

Use search to you find a client based on last name, first name, or ID.   

To run a search, select File > Search Client or click on the  button in the upper left 
corner. 

When the Search Client box appears, select the criteria for your search and/or enter a 
keyword/letter, for example last name, or the first letter of the last name. 

38 



Polar BodyAge System SW Help 

 

Click Search and all the clients that meet the criteria will be displayed. 

Deleting a Client 

To delete a client, select File > Delete Client. 

 

The following message appears:  

 

Clicking Yes permanently removes a client’s data.  Clicking No cancels the operation.   
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Testing 

Pre-Test recommendations 

Before any exercise testing is done, the following is recommended by Polar/HealthFirst: 

• PAR-Q (Physical Activity Readiness Questionnaire) should be completed by the client.  If "Yes" 
is answered to ANY of the seven (7) questions, it is recommended that the client sees a doctor 
before performing any physical activity or exercise testing. 

• MEDICAL HISTORY questionnaire must also be completed, printed out and kept in the client's 
file in hard copy. 

General guidelines to be given to client before any testing: 

• Wear comfortable, loose-fitting clothing. 

• Drink plenty of fluids over the 24-hour period preceding the test. 

• Avoid food, tobacco, alcohol and caffeine for 3 hours prior to taking the test. 

• Avoid exercise or strenuous physical activity the day of the test. 

• Get an adequate amount of sleep (6 to 8 hours) the night before the test. 

Test Environment 

The test environment is important for test validity and reliability.  Anxiety, emotional problems, 
food in the stomach, bladder distention, climate variation, and pain should be controlled as much 
as possible. To minimize anxiety, the test environment should be quiet and private and the 
temperature of the room maintained at about 72°F/22°C. The room should be equipped with a 
comfortable seat and/or examination table to be used for resting blood pressure. The demeanor 
of personnel should be one of relaxed confidence so as to immediately put the subject at ease. 
Testing procedures should not be rushed, and all procedures must be clearly explained prior to 
initiating the process. These seemingly minor tasks are easily accomplished and will assist in 
achieving valid test results. 

Importance of Test Order 

When exercise testing a client you must consider the testing battery order. For example: if a 
cardiovascular test is given first, then a blood pressure measurement is taken, the blood pressure 
measurement will be affected by the cardiovascular test.   

Manual Entry  
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After any manual entry, press the enter on the keyboard to save data. These changes will now be 
seen in the reports.   

General Guidelines for the Client 

General guidelines to be given to client before any testing: 

• Wear comfortable, loose-fitting clothing. 

• Drink plenty of fluids over the 24-hour period preceding the test. 

• Avoid food, tobacco, alcohol and caffeine for 3 hours prior to taking the test. 

• Avoid exercise or strenuous physical activity the day of the test. 

• Get an adequate amount of sleep (6 to 8 hours) the night before the test. 

Main Screen View - Testing 

After you have created a new client (see Adding a New Client), the following view opens: 
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1. If you want to change the client, go to Clients tab. 
Click the name of the client. 

 

2. Select one of the existing test protocols or create a 
new  test protocol for the client. For more information, 
see Test Protocols and Adding, Editing or Deleting a 
Test Protocol. 

3. To carry out a test by using the Autopilot, click 
Testing and select New Test Result Using Autopilot 
or Edit Test Result Using Autopilot.  For more 
information, see Testing With Autopilot. Alternatively 
you can add or edit the test records manually by 
clicking Testing and selecting New Test Record or 
Edit Test Record. For more information, see Testing 
Manually. 

 

 

 

 

 

 

Test Protocols 
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A test protocol is a group of fitness assessments and health risk appraisals that you want to 
display on the main page or in the AutoPilot. You can make your own test protocol and name it 
accordingly so that each time you test a client, you can select the test protocol from a drop-down 
menu. For more information, see Adding, Editing or Deleting a Test Protocol. 

The default test protocol is called Body Age and includes the following assessments: 

PAR-Q (Physical Activity Readiness Questionnaire), Medical History, Height/Weight, Blood 
Pressure, BioImpedance, OwnIndex, OwnZone, Crunch, Bicep Strength, Wall Sit, Sit & Reach 

For more information on the assessments, see Fitness Assessments and Health Risk Appraisals. 

Adding, Editing or deleting a test protocol 

To add or edit a test protocol, click Test Protocol and select Add, Edit or Delete Test 
Protocols: 

 

The following screen appears:   
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If you have already created a test protocol, you can click Next to edit it. 

To create a new test protocol, click New Test Protocol. Enter a name for the test protocol and 
check the box for the features you want to include in the test protocol, then click Next. 

If you want to delete a particular test protocol, select the group from the drop-down menu and 
click Delete Protocol. 

***NOTE: you cannot modify or delete the BodyAge test protocol.  

Select the assessments from the menu.   
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For Body Composition Assessments, only one assessment can be selected per test protocol. 

For Cardiovascular Assessments, only one assessment plus OwnZone can be selected per 
test protocol. 

Click Next after making you selections. A menu appears where you can select the health risk 
appraisals you want to include in the test protocol.   
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Click Next after making your selections. In the following view you can customize the order of the 
assessments in Autopilot. 
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To change the order of the assessments, highlight an assessment and click Move Up or Move 
Down. 

Click Finish to save your test protocol.   

Your new test protocol will now appear under the Test Protocol drop-down menu.  

Fitness Assessments 

The fitness assessments in a test protocol are divided into four categories: Biometrics, 
Cardiovascular, Body Composition and Strength & Flexibility.  
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If you want to view an assessment that is not included in the test protocol, click the Other 
Assessments button (Other Biometric Assessments, for example). When you use an 
assessment that is not included in the test protocol, it will be indicated by red text.  

NOTE: To view the Other Assessments button in Fitness Assessments, Other Categories 
must be included in the test protocol. For more information, see Adding, Editing or Deleting a Test 
Protocol. 

Biometrics 

The following assessments can be found in Fitness Assessments > Biometrics. For more 
information on a specific assessment, click the name of the assessment below. 

PAR-Q

Medical History

Girth

Height/Weight

OwnZone
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Blood Pressure

Blood Chemistries

Body Composition 

The following assessments can be found in Fitness Assessments > Body Composition.  For 
more information on a specific assessment, click the name of the assessment below. 

3-Site SkinFold

7-Site SkinFold

Bioimpedance

Direct Value Body Fat Percent

For more information on body composition, see Importance of Body Composition. 

Cardiovascular 

Before starting a cardiovascular test, see Guidelines for Cardiovascular Testing. 

The following assessments can be found in Fitness Assessments > Cardiovascular.  For more 
information on a specific assessment, click the name of the assessment below. 

Treadmill

Cycle Ergometer

Cooper 12 Minutes Run/Walk

Direct Value VO2max

One Mile Walk

OwnIndex

For general cardiovascular information, see the following sections: 

About Cardiovascular Fitness

About the Polar WindLink

Major Symptoms or Signs of Heart Disease
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Heart Disease Risk Factors

Strength and Flexibility 

The following assessments can be found in Fitness Assessments > Strength and Flexibility. 
 For more information on a specific assessment, click the name of the assessment below. 

1-RM Bench Press

1-RM Leg Press

60 sec. Sit-Ups

Bicep Strength

Crunch

Max Push Up

Sit & Reach

Wall Sit

Health Risk Appraisals 

Health Risk Appraisals 

Click on the Health Risk Appraisals tab to view the appraisals included in the test protocol. 

 

To open a health risk appraisal questionnaire, heart disease for example, click on Heart Disease. 
Then click on Start the Heart Disease Assessment. 
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If you want to open the questionnaire for a health risk appraisal that is not included in the test 
protocol, click on Other Health Risk Appraisals. 

Using Heart Disease HRA 

The Heart Disease HRA questionnaire consists of 9 questions. The heart disease questionnaire 
requires weight information to correctly assess the heart disease risk for an individual.   

Coronary heart disease is the most common form of heart disease and the leading cause of 
death globally. Estimates are that almost 7.6 million deaths a year are due to coronary heart 
disease. Many of these deaths could be avoided by simply understanding the risk factors 
associated with coronary heart disease and what steps can be taken to reduce the risk.   

The heart disease HRA uses assessment data as part of the scoring. Blood pressure and blood 
chemistry values are needed to get the most accurate score for this HRA. 

Using the Nutrition HRA 

The Nutrition HRA questionnaire consists of 12 questions.   

Good nutrition is essential for maintaining health and providing the energy necessary for optimal 
physical and mental performance. Poor nutrition is a significant risk factor in many of the leading 
causes of death globally, including coronary heart disease, cancer, stroke, and diabetes.   

Using the Stress HRA 

The Stress HRA questionnaire consists of 19 questions.   

Stress may be thought of as a reaction to real or imagined threats in the present or future and to 
feelings of vulnerability or weakness. Even the most psychologically stable persons will have 
occasional periods of stress. Relatively mild episodes of stress are universal and require no 
special treatment. But, in some people, these emotions can gather momentum and have a 
negative effect on the quality of life and health. In most cases individuals can manage and control 
stress on their own. The trick is to recognize the problems for what they are and to take 
appropriate corrective actions.   

Using the Depression HRA 

The Depression HRA questionnaire consists of 20 questions. 

Depression may be thought of as a reaction to past events combined with feelings of 
helplessness and hopelessness. Even the most psychologically stable persons will have periods 
of depression. Relatively mild episodes of depression are universal and require no special 
treatment. But, in some people, these emotions can gather momentum and have a negative 
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effect on the quality of life and health. The trick is to recognize the problems for what they are and 
to take appropriate corrective actions.  

Using the Diabetes HRA 

The Diabetes HRA questionnaire consists of 9 questions. 

Diabetes is a serious disease that can lead to blindness, heart attack, stroke, kidney failure and 
amputations.  Research shows that type II diabetes can be prevented by leading a healthy 
lifestyle. Maintaining a healthy weight, eating low fat foods, and getting regular exercise can help 
reduce risk.   

Using the Cancer HRA 

The Cancer HRA questionnaire consists of 26 questions for males and 37 questions for females. 

The cancer risk assessment has been developed by the American Cancer Society to help you 
learn about: 

1. your risk factors for certain types of cancer and  

2. the early symptoms of a cancer 

Using the Prevention HRA 

The Prevention HRA questionnaire consists of 13 questions. 

Using the Safety HRA 

The Safety HRA questionnaire consists of 23 questions. 

 

Testing with Autopilot 

What is AutoPilot? 

AutoPilot has been designed to streamline and standardize the sequencing of fitness 
assessments. By creating a new record with AutoPilot, each desired assessment comes up 
automatically in the desired order. Running a test protocol with AutoPilot means that you never 
have to select the assessment you want to use. As you complete one assessment of the test 
protocol, the next assessment appears automatically.  

How to start AutoPilot 
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AutoPilot will automatically run with the test protocol that you select. To change the test protocol 
settings or selection, see Test Protocols and Adding, Editing or Deleting a Test Protocol for 
instructions.  

1. Click Testing to open the drop-down box and select New Record Using AutoPilot to create a 
new test record or Edit Test Record Using AutoPilot to edit an existing test record. 

 

2. A new screen will appear. This is the first assessment to complete in order to run a complete 
test protocol.  

3. When you are finished with the first assessment, click OK in the lower right corner and you will 
be automatically forwarded to the next assessment.  

4. To close AutoPilot and return to the main screen, click on the   button.  

To view an existing record, use the arrows or the drop down menu shown below: 

 

Testing Manually 

After you have created a new client (see Adding a New Client), you can create a record for that 
client.   

Every time you add a new client, your main testing screen will be disabled until you click Testing 
and make your selection: 
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Select New Record to create a new record for the client. The main testing screen will be enabled. 
You can now select the assessment you want to view. For example, if you want to enter the 
clients height and weight, click on the Height/Weight button in Biometrics category. A screen for 
entering a client's height and weight will appear. 

 

Select Edit Record to modify an existing record. 

Select Delete Record to permanently remove the record. 

To view an existing record, use the arrows or the drop-down menu shown below: 

 

NOTE: If you have created a new client, you can only select New Record or New Record Using 
Autopilot. 

Programs 

Creating a New Program 

To design a customized program for your client, click on the Programs tab to open the program 
view. Then click the button and select New Program. 
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The following view appears: 

 

For more information on the options in this view, see the links below.  

Cardiovascular Program

Strength Training Program

Training Progress

Other Programs

Energy Balance

Cardiovascular Program 

To design a customized cardiovascular program for your client, click on the Programs tab to 
open the program view. Then click on and select New Program. 

 

The following view appears: 

 

Start by selecting the client's training computer from the drop-down list. This selection will 
determine the program type. Depending on the training computer selection, click on the program 
name below for further instructions: 
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• Polar Keeps U Fit program: F4, F6/F7, F11, F55 

• Polar Energy Pointer program: FT7, FT40  

• Polar STAR Training Program: FT60, FT80 

• 5 Zone Program: RS300X, RS400, RS800, RS800CX 

 

 

Strength Training Program 

To design a customized strength program for your client click on the Programs tab to open the 
program view. Then click on and select New Program. 

 

The following view appears: 

 

1. Click on the Strength Training Program tab to view the strength training program main 
screen. 

2. Click Create New Workout. The following screen appears:  
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3. If you have already created a workout template, select it from the drop-down menu. If you want 
to create a new workout, enter the workout name. 

 

4. Select the muscle group in which you want to add exercises. Double-click or drag and drop the 
exercise to add it to the workout. 
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5. If you want to add a new exercise, click Add. 

• Give the exercise a name and place it in a muscle group. 

• Browse to find the picture that corresponds with the new exercise. 

• Write the instructions for the new exercise. 

58 



Polar BodyAge System SW Help 

 

6. If you want to save the workout as a template, check the box next to Save as Template. Then 
select Save. 

7. After saving the workout, a weekly calendar appears on the Strength Program main screen. 
Select the days when this workout should be done. 

 

8. Click Report to view and print a strength program. The report includes a strength training 
calendar and detailed instructions for carrying out the exercises. 
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9. To transfer workouts (a maximum of three) to the Polar FT80 training computer, place the 
training computer on the FlowLink and click Send to training computer... 

The following screen appears. Check the boxes next to the workouts you want to send to the 
training computer and click Transfer. 

 

 

Training progress 

To view and follow your client's training progress, click on the Programs tab to open the program 
view. Then click on and select New Program. 

 

The following view appears: 
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1. Click on the Training Progress tab to view the training progress main screen. 

 

2. Click Download File to download the training files from the client's training computer. Select 
the training computer and the sport from the drop down lists and then click Download. See 
Downloading Files for more information. 

3. Click Add File Manually to add a training file manually. A new file will be added to the list. 
Enter the information for the highlighted training file, and click Save to save the training file 
information. 
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4. To delete a highlighted training file from the list, click Delete File. 

5. To view a training progress report, click Report. 

 

Other Programs 

In Other Programs you can include additional programs or training instructions for you client. 
Click on the Programs tab to open the program view. Then click on and select New 
Program. 

 

The following view appears: 

 

1. Click on the Other Programs tab brings to view the other programs main screen.  
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To add one of the program templates for your client, highlight the program name and click  Add.  

To create a new template, click New. This selection will open a text editor. After creating the 
template in the text editor, select File > Save.  

Energy Balance 

The Energy Balance function calculates the total daily calorie burn target based on the client’s 
weight loss target and daily activity level. 

Click on the Programs tab to open the program view. Then click on and select New 
Program. 

 

The following view appears: 
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Clicking on the 
Energy Balance tab 
brings up the 
Calorie Analysis 
view. 

This view provides 
an analysis of the 
client's total daily 
calorie burn. 
Choose the lifestyle 
that best describes 
the client's daily 
activity level. 
Clicking on the  
button brings up a 
screen with 
descriptions of the 
lifestyle options. 

 

After the lifestyle 
selection, the 
following data will be 
displayed in the 
calorie analysis view 
automatically: 

• RMR: 
Resti
ng 
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meta
bolic 
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is the 
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weekl
y 
total 
and 
the 
energ
y 
balan
ce 
functi
on 
divide
s that 
by 7 
for 
daily 
calori
e 
expe
nditur
e. 

• Total 
Calor
ie 
Burn/
Day 
is a 
sum 
of the 
lifesty
le, 
RMR 
and 
avera
ge 
exerc
ise 
calori
es.  

Once the calorie analysis is complete, the Targets view appears. 
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In this view, the Current values show the client's current condition. The body fat, lean mass and 
weight are brought over from Body Composition assessments and Client Information. 

The Goal values can be adjusted by sliding the bars or by manually entering a goal value in each 
text box. The Weight Change/Week will change accordingly. 

Reports 

Graphical Summary 

A graphical summary gives the client a graphical view of how they did on the fitness assessment. 
It presents norms and places clients into categories based on their health or performance.   

To build a graphical summary report, select Reports > Graphical Summary. The Graphical 
Summary report window appears: 
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Check the box next to the record you want to compare. You may compare all records or choose 
individual records for comparison. 

Click Preview to view the report before printing. Click on the  button to print the report, or the 

  button to exit the graphical summary preview and return to the main screen.  

Click Print to print the report. 

Summary Report 

A data summary report will present the client’s data from the fitness assessment. It will also 
reflect the changes made if more than one record is compared.   

To build a summary report, select Reports > Summary Report. The Data Summary Report 
window appears: 
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The first option allows you to compare the results of the current test to one of the client's other 
tests.  You can compare it by selecting an earlier test record from the drop-down menu. The 
second option shows only the current test record. 

Click Preview to view the report before printing.   

Click on Print to print out the data summary report. 

Personal Profile 

A personal profile presents an in-depth report of the client’s fitness assessment.  It uses graphs, 
percentages, charts, norms and tips to give the clients detailed, yet easy to understand feedback 
on their fitness status. It also prints out their cardiovascular program and training progress if they 
are created and selected.  

To build a personal profile report, select Reports > Personal Profile. The Personal Profile 
Report window appears: 
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Check marks indicate reportable data. If you do not want all of the selected data in the report, 
either remove the check marks one by one or click Unselect All.   

Click Preview to view the report before printing. 

Click Print to print out the personal profile. 

Click Set Print Order to select the order in which the personal profile information is printed.  
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To change the order, highlight the item and use the up and down arrow buttons to move it.  

NOTE: The cover page cannot can not be moved, it is ALWAYS the first page.  

When you have it in the order that you want, click on Close button. 

BodyAge Report 

A BodyAgeTM report is generated if it is selected when printing or previewing a personal profile.  

Why BodyAge 

BodyAge is based on health screening and fitness test scores. Fitness testing is done to serve 
two purposes; the first is to monitor progress of a fitness program and the second is to provide 
motivation to the client to improve fitness levels. The problem in the past has been that when 
presenting clients with just their fitness results: they tend to be overwhelmed with the amount of 
information and do not understand many of the fitness concepts, such as VO2MAX. Because of this, 
clients tend to be less motivated to change their fitness levels and therefore exercise adherence 
is lower and incidence of dropout from exercise programs is higher. The BodyAge system was 
developed over 10 years from the information gathered and real-world testing in over 1300 health 
clubs in the U.S. 

BodyAge simplifies fitness test results into one number that the non-professional can understand. 
Using BodyAge has been shown to increase motivation levels of clients and increase exercise 
compliance. 

How BodyAge Works 
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The BodyAge score is calculated using 4 to 13 health and fitness assessments.  Each 
assessment has a "Healthy" or "Average" percentile ranking that has been determined and 
validated by a research (example: VO2MAX values and normative rankings from Shvartz E, Reibold 
RC: Aerobic fitness norms for males and females aged 6 to 75 years: a review. Aviat Space 
Environ Med; 61:3-11, 1990. as reference by the World Health Organization).  A person in the 
"Healthy" or "Average" percentile for all assessments will have a BodyAge score equal to their 
biological age. A person lower in the percentile categories for any of the assessments will have 
years added to their BodyAge score accordingly. The same works for the person in the Good or 
Excellent categories-years will be taken off of the BodyAge score. Assessments that affect life 
expectancy are weighted more heavily. Assessments that affect quality of life rather than lifespan 
are weighted slightly less.  

Customizing Report Cover Page 

To view and/or change the cover page for the personal profile report, select System Settings > 
Customize Report Cover Page.  

The cover page opens. In this view you can change the formatting, wording, colors and even add 
your own images.   
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To change the text, place the cursor on the part that you want to change or delete text. The tags 
listed (i.e. <FullName>) indicate that a personalized tag (i.e. John Doe) will show up on the cover 
page.  

To change the format, font, and/or text features, use the tool bar.  

To insert an image or logo, go to Insert > Image... and browse the file from your computer.  

When the cover page is complete, go to File and select Save. Click Close to exit.  

 

Group Reports 

Group Reports are aggregate summaries of group populations. These reports are extremely 
useful in corporate settings.  

To build a group report, select Reports > Group Report. The Group Reports window appears: 
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1. If you want to compare two groups, click on the arrow on the lower left corner of the screen to 
raise the number of groups from 1 to 2. A Group 2 tab will appear. 

2.  Select a group from the drop-down list next to the group field. If you want to create a new 
group with a specific population of clients, select Query, and click on .  

 

See Query Builder for more information. 

3. The report filter customizes your report. You can filter your group report based on age or sex or 
test date or all three.  For example, you can choose only males between the ages of 25 and 40 
years of age within your group report.   

4. Press Next. The following screen will appear allowing you to choose the assessments and 
health risk appraisals to be included in the report. 

 

5. Press Next to complete the report. The following screen appears: 
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Click Print to print out the summary report. 

Click Preview to view the report before printing.   

Click Export Records to save the data in .xml format. 

Batch Report 

The batch report function allows you to compile a report of chosen assessments for a specific 
group of people.  

To build a batch report, select Reports > Batch Report. The Batch Printing window appears: 
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1. If you do not want all of the listed assessments to be included in the report, remove the checks 
you do not want to include in the report or click Unselect all.  

2. Select the type of the report by checking or unchecking the box next to the report type: 
 Personal Profile, Data Summary or Graphical Summary. You can select more that one report 
type to be included in the batch report.  

3. If you want to attach a form letter to the report, check the box next to Form Letters. Then 
check the box next to the form letter which you want to attach.  For more information on form 
letters, see Define Form Letters. 

4. Click Next. The following screen appears. 
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5. Choose the delivery method and select the recipients from the drop-down list. If you want to 
create a new group with a specific population of your clients, click on .  

 

See Query Builder for more information. 

6. If the delivery method of you choice is Email reports, the below screen will appear. Create the 
e-mail content, and click Finish to send the reports. 
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Support for the Polar BodyAge System 

Troubleshooting 

Computer will not turn on 

1. Turn the main power switch, located on the right side of the computer compartment, off and on. 
 If power is applied, the switch will glow red. 

2. Hold the power button on the front of the CPU down for 2 seconds.  If the switch glows green, 
power is on. 

3. Unplug the unit and test the wall power outlet with an electrical appliance (such as a lamp).  If 
outlets are changed, repeat steps 1 and 2. 

4. Unplug the ROM cable from the system interface. Slowly remove the computer and set it down 
directly behind the cart.  Make sure the power cable is securely plugged in on the back of the 
case as well as the surge protector. 

5. Repeat steps 1 and 2. 
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Computer turns on, but the monitor does not 

1. Check the power cable on the back of the monitor.  Make sure it is secure. 

2. If no lights are on in the monitor, press the monitor power switch again.  Wait for 30 seconds. 
 Note the color of the monitor lights. 

3. If there is power on in the monitor, but you have no video (amber light), reseat the VGA cable 
on the back of the monitor. 

4. If power is still not applied (no lights), turn off the main power switch on the left rear of the cart. 
 Unplug the ROM cable from the system interface. Slowly remove the computer and set it down 
directly behind the cart.  Make sure the AC adapter for the monitor is securely plugged in on the 
surge protector and the body of the adapter. 

5. Turn on the main power switch and check again. 

6. If you have power to the monitor (lights on the front) and still no video, verify that the VGA 
cable is securely connected on the rear of the computer. 

Printer will not Turn On or Print 

Hardware checks 

1. Check the power cable going into the right side of the back of the Hewlett Packard printer. 

2. Check the data cable (USB) going into the right side on the back of the Hewlett Packard 
printer. 

3. Turn off the main power switch on the left rear of the cart.  Unplug the ROM cable from the 
system interface. Slowly remove the computer and set it down directly behind the cart. Verify that 
the AC adapter for the printer is securely connected to the surge protector.   

4. Check the back of the computer to see that the USB cable is securely connected. 

5. Check the printer cartridges as described in the Hewlett Packard material, which came with the 
printer (located in the accessories box). 

Software Checks 

1. Close the BodyAge system. 

2. Click Start. 

3. Go to Printers. 
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4. With the mouse, highlight the printer you are using and click the right mouse button. 

5. Go to Properties and click the left mouse button. 

6. The printer should be checked as being the default printer.  If it is not, click on the default. 

7. Write down any error codes to help identify any problem. 

On-Line Peripherals 

PLATFORM 

Platform is giving low or high readings  

• Re-calibrate (Defaults/Calibration) being sure to follow the instructions on the screen exactly. 

• Use a person who has a known weight between 68 and 86 kg or 150 and 189 lbs. 

• Make sure the person does not step on the scale before it is zeroed. Stepping on the scale 
causes the platform calibration to fail. 

• Make sure the person stands very still.  Any movement from side to side will cause the 
calibration to fail. 

• Go to a test and perform an actual body weight with the same person that was used to calibrate 
the scale.  The weight should be within 0.5 kg / 1.1 lbs.   

• If the weight is not within 0.5 kg / 1.1 lbs, re-calibrate and re-measure the body weight.  

CALIPERS 

Online calipers are giving inaccurate readings 

• Re-calibrate as instructed on the screen. (Defaults/Calibration). 

• Go into a 3-site Skinfold test.  

• Zero the calipers. 

• Place the 25.4mm calibration dowel in the jaws of the calipers lengthwise. 

• Press the switch on the calipers. 

• The reading on the screen should be within 24.5mm and 26.0mm. Repeat this three times and 
note each reading. 
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• If the readings are not within 24.5mm and 26.0mm, re-calibrate and repeat. 

SIT & REACH (Range of Motion) 

Range of motion (ROM) handle is not retracting 

• If the ROM handle is not retracting, the internal mechanism needs to be repaired by 
Polar/HealthFirst service personnel.   

• Remove the ROM unit from the sit & reach station using a 5/32” Allen wrench provided with your 
system. 

• Remove the two upper screws mounting the unit to the station.  

• Unplug the ROM cable from the system. 

• Remove the ROM unit. 

Range of motion is inconsistent 

• Re-calibrate ROM. See Calibrating the Range of Motion for instructions. 

• Enter into a client test and perform another sit and reach test. 

• When the screen prompts to “Zero the System”, pull the handle out exactly 30 cm (11.8 inches) 
from the footplate and press the Enter key. 

• Return the handle slowly to the footplate and allow the TriFIT to take the reading.   

• The measurement should be within 1 cm (0.4 inches) of 30cm  (11.8 inches). 

• If the measurement is not within 1 cm (0.4 inches) , re-calibrate and repeat. 

Limited Polar International Warranty for Polar bodyage System 

Polar Electro Group (Polar) warrants its equipment for one year from the date of shipment. This 
warranty is limited and is in lieu of all other warranties expressed or implied. Within the warranty 
period, Polar or its local representative will repair or replace, without charge, any parts, which 
become defective due to material or workmanship.  

Accessories, components and major sub-assemblies of Polar systems not manufactured by Polar 
(i.e. Bike Ergometer, HP Computer, Tanita Body Composition Analyzer) will be warranted 
according to the terms of the original manufacturer. This warranty shall not apply to any part or 
parts of the system if it has been altered, repaired or misused through negligence; nor does this 
warranty cover replacements or repairs necessitated by loss or damage resulting from any cause 
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beyond the control of Polar including but not limited to natural disasters or other such 
circumstances and effects from other equipment being used at the same time, acts of 
Government and labour disputes.  

The above warranty provisions do not apply to any “consumer products” in that the products 
described herein should not and are not normally used for personal family or household. 

 

License Agreement 

***Important: By using this software you accept the following terms of this License Agreement. If 
you do not agree with these terms, you should not use the software and promptly return it for a 
refund.  

Ownership  

Polar retains the ownership of this copy of the enclosed software package. It is licensed to you for 
use under the following conditions.  

Grant of License  

You may only concurrently use the enclosed software on the number of computers for which this 
license grants (for example, single-user version licenses one concurrent usage; five-user network 
version licenses five concurrent usages). If the number of users of the software exceeds the 
licenses, you must have a reasonable process in place to assure that the number of persons 
concurrently using the software does not exceed the number of licenses.  

Restrictions  

You may not copy the documentation or software except as described in the installation section of 
the user manual. You may not distribute, rent, sub-license or lease the software or 
documentation, including translating, decompiling, disassembling, or creating derivative works. 
You may not reverse-engineer any part of this software, or produce any derivative work. You may 
not make telecommunication transmittal of this software.  

Termination  

This license and your right to use this software automatically terminates if you fail to comply with 
any provision of this license agreement.  

Rights  
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Polar retains all rights not expressly granted. Nothing in this license agreement constitutes a 
waiver of Polar’s rights under the European or the U.S. copyright laws or any other Federal or 
State law, or any other applicable law.  

Applicable law 

This Agreement is governed by and shall be construed in accordance with the laws of Finland. 

 Jurisdiction 

Any and all disputes that may arise between the Parties under or in connection with this 
Agreement shall be finally settled in arbitration in accordance with the Rules of Arbitration of the 
Finnish Central Chamber of Commerce. Arbitration shall be conducted in Helsinki, Finland, in the 
English language. Notwithstanding the foregoing, the Seller shall, at its own discretion, have the 
right to initiate legal proceedings against the Buyer in any competent court of law for the purpose 
of collecting unpaid fees or other payments under this Agreement. 

 

Limited Warranty (software) 

If you discover physical defects in the media, Polar will replace the media or documentation at no 
charge to you, provided you return the item to be replaced with proof of payment to Polar during 
the 90-day period after having taken delivery of the software.  

Polar excludes any and all implied warranties, including warranties of merchantability and fitness 
for a particular purpose and limits your remedy to return the software and documentation to Polar 
for replacement.  

Although Polar has tested the software and reviewed the documentation, POLAR MAKES NO 
WARRANTY OF REPRESENTATION, EITHER EXPRESSED OR IMPLIED, WITH RESPECT 
TO THIS SOFTWARE OR DOCUMENTATION, ITS QUALITY, PERFORMANCE, 
MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. AS A RESULT, THIS 
SOFTWARE AND DOCUMENTATION ARE LICENSED “AS IS” AND YOU, THE LICENSEE, 
ARE ASSUMING THE ENTIRE RISK AS TO ITS QUALITY AND PERFORMANCE.  

IN NO EVENT WILL POLAR BE LIABLE FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE 
SOFTWARE OR DOCUMENTATION, even if advised of the possibility of such damages. In 
particular, Polar shall have no liability for any data stored or processed with this software, 
including the costs of recovering such data.  

THE WARRANTY AND REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND IN LIEU OF 
ALL OTHERS, ORAL OR WRITTEN, EXPRESSED OR IMPLIED. No Polar dealer, agent, or 
employee is authorized to make any modifications or additions to this warranty.  
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Information in this document is subject to change without notice and does not represent a 
commitment on the part of Polar. The software described in this document is furnished under this 
license agreement. The software may be used or copied only in accordance with the terms of the 
agreement. It is against the law to copy the software on any medium except as specifically 
allowed in the license agreement. No part of this manual may be reproduced or transmitted in any 
form or by any means, electronic or mechanical, including photocopying and recording, for any 
purpose without the written permission of Polar. 

Security 

User Roles and Profiles 

User Roles 

In User Roles you can determine the functions that are allowed for different roles.  

1. Select Preferences > User Management > User Roles. The following window ppears: 

 

2. Click a role and then determine the functions that are allowed for this role by checking the box 
next to each function you want the role to have.  

3. Click Save to save the data. 
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User Profiles 

In User Profiles you can create new users and select the role that will be given to the user.  

1. Select Preferences > User Management > User Profiles from the  menu. The following 
window appears. 

 

2. Insert the user data to the text fields, and select the role from the drop down list.  

3. Click Save to save the data. 

Database Management 

Backup 

Select Preferences > Database Management. The following window appears informing you that 
running database management requires closing the system: 
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In order to backup, you need to close the BodyAge system. To run database management, click 
Yes. The following window appears: 

 

Browse the location for the backup data and click Backup.  

Backup directory will show you all of the databases that have been saved previously to the 
backup folder. 

Restore 

Select Preferences > Database Management. The following window appears: 
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In order to restore the data, you need to close the BodyAge system. To run database 
management, click Yes. The following window appears: 

 

Open the Restore tab. Browse for the backup file and click Restore.  

Backup Directory will show you all of the databases that have been previously saved to the 
backup folder. 

More... 

1-RM Bench Press 

One repetition maximum in bench press: client performs one repetition of bench press with 
maximum weight. 
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Click on 1-RM Bench Press link from the Strength & Flexibility section of Fitness 
Assessments  to view the screen for entering the client's test result. The test's input box 
appears. After entering the result, the line graph shows where the user ranks in the norm. 

 

 

1-RM Leg Press 

One repetition maximum in leg press: client performs one repetition of leg press with maximum 
weight. 

Click on 1-RM Leg Press link from the Strength & Flexibility section of Fitness Assessments 
 to view the screen for entering the client's test result. The test's input box appears. After entering 
the result, the line graph shows where the user ranks in the norm. 
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3-Site Skinfold 

Guidelines for Skinfold Measurements 

NOTE: With all body composition measurement techniques, the technician must be well-trained, 
routinely practice the technique, and demonstrate reliability in his/her measurements before 
collecting actual data. 

• All measurements should be made on the right side of the body. 

• Caliper should be placed 1 cm away from the thumb and finger, perpendicular to the 
skinfold and halfway between the crest and the base of the fold. 

• Wait one to two seconds before taking the measurement. 

• The actual fold measurement will be displayed on the screen after each measurement. 

• When all sites have been measured, a pie chart with percentage of the fat and lean body 
mass will appear. 

3-Site Skinfold Sites 

Men  

Chest: Diagonal fold; one-half the distance between the anterior axillary line and the nipple. 

Abdomen: Vertical fold; two cm to the right side of the umbilicus. 

Thigh: Vertical fold; on the anterior midline of the thigh, midway between the proximal border of 
the patella and the inguinal crease (hip). 

Women 

Triceps: Vertical fold; on the posterior midline of the upper arm, halfway between the acromion 
and olecranon processes, with the arm held freely to the side of the body. 

Suprailiac: Diagonal fold; in line with the natural angle of the iliac crest taken in the anterior 
axillary line immediately superior to the iliac crest. 

Thigh: Vertical fold; on the anterior midline of the thigh, midway between the proximal border of 
the patella and the inguinal crease (hip). 

Using 3-Site Skinfold 

This is the view of the 3-site on the main screen.   
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Enter the values manually here or click on the 3-Site SkinFold link to view the 3-Site Skinfold on-
line measurement screen.   

 

Use the calipers to measure the skinfolds according to the guidelines and sites.  

When the caliper is pinching the skin in the proper position, click the switch on the back of the 
calipers and the value will appear in the text field.  

The test automatically advances to the next measurement.  

When you complete all skinfold measurements, a pie chart will be generated showing the client’s 
body composition.   
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Click OK to save the data and to return to the main screen. 

5 Zone Program 

A 5 zone program can be created for the following training computers: RS300X, RS400, RS800, 
RS800CX. 

Select the start 
date and the 
number of 
weeks that the 
program will 
last. 

 

 

Enter the 
following 
information: 

• The 
numbe
r of 
days 
per 
week 
that 
the 
client 
will be 
exerci
sing 
(the 
recom
mende
d 
numbe
r of 
days 
is 
given 
based 
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on the 
VO2m
ax 
score 
and 
the 
client's 
goal).  

• The 
sports 
that 
the 
client 
will be 
doing 
while 
exerci
sing.  

• Select 
intensi
ty 
zones 
based 
on 
Maxi
mum 
heart 
rate or 
Anaer
obic 
thresh
old 

• Re-
name 
the 
sessio
ns and 
define 
intensi
ty 
zones 
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accord
ing to 
trainin
g 
targets 
(click 
the 
field to 
activat
e the 
text 
screen
) 

 

You can print 
the 5 Zone 
Program by 
clicking 
Program 
Report. 

Click Send to 
HR Monitor 
from the 
Cardiovascular 
Program main 
screen to 
upload user 
information 
and sport 
zones to the 
client's watch. 

 

You can download the training files from the client's training computer to create a training 
progress report. See Training Progress for instructions on downloading training files.  

60 sec. Sit-Ups 

In 60 sec. sit-up test the client repeats as many sit-ups as she/he can in 60 seconds time. 

93 



Polar BodyAge System 

Click on 60 Sec. Sit-Ups link from the Strength & Flexibility section of Fitness Assessments 
to bring up the instructions for performing the sit-up test. 

 

After reading the instructions, click Continue. The following screen appears:  
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When the client is ready to begin the test, click Start. The timer will count down from 1 minute.   

To count the number of full repetitions, click an alphanumeric key on the keyboard each time a 
repetition is completed.   

When the minute is up, the timer will automatically stop and beep to indicate that the test is over.  

Click OK to save the data and return to the main screen.  

7-Site Skinfold 

Guidelines for Skinfold Measurements 

NOTE: With all body composition measurement techniques, the technician must be well-trained, 
routinely practice the technique, and demonstrate reliability in his/her measurements before 
collecting actual data. 

• All measurements should be made on the right side of the body. 

• Caliper should be placed 1 cm away from the thumb and finger, perpendicular to the 
skinfold and halfway between the crest and the base of the fold. 
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• Wait one to two seconds before taking the measurement. 

• The actual fold measurement will be displayed on the screen after each measurement. 

• When all sites have been measured, a pie chart with percentage of the fat and lean body 
mass will appear. 

7-Site Skinfold Sites 

7-Site skinfold site are the same for men and women. 

1. Chest:  Diagonal fold; one-half the distance between the anterior axillary line and the nipple.  

2. Midaxillary:  Vertical fold; on the midaxillary line at the level of the xiphoid process of the 
sternum.  An alternate method is a horizontal fold taken at the level of the xiphoid/sternal border 
in the midaxillary line. 

3. Tricep:  Vertical fold; on the posterior midline of the upper arm, half-way between the acromion 
and olecranon processes, with the arm held free to the side of the body. 

4. Subscapular:  Diagonal fold (at a 45 degree angle); one to two cm below the inferior angle of 
the scapula. 

5. Abdomen:  Vertical fold; two cm to the right of the umbilicus. 

6. Suprailiac:  Diagonal fold; in line with the natural angle of the iliac crest taken in the anterior 
axillary line immediately superior to the iliac crest.  

7. Thigh:  Vertical fold; on the anterior midline of the thigh, midway between the proximal border 
of the patella and the inquinal crease (hip).  

Using 7-Site Skinfold 

This is the view of the 7-site on the main screen.   
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Enter the values manually here or click on the 7-Site SkinFold link to view the 7-Site Skinfold on-
line measurement screen.   

 

Use the calipers to measure the skinfolds according to the guidelines and sites (see above 
sections).  

When the caliper is pinching the skin in the proper position, click the switch on the back of the 
calipers and the value will appear in the text field.  
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The test automatically advances to the next measurement.  

When you complete all skinfold measurement, a pie chart will be generated showing the client’s 
body composition.   

Click OK to save the data and to return to the main screen. 

About Cardiovascular Fitness 

Cardiovascular or aerobic fitness relates to how well your cardiovascular system works to 
transport oxygen to your body. The better the cardiovascular fitness, the stronger and more 
efficient your heart is.   

Having good cardiovascular fitness has many health benefits. For example, it decreases your risk 
of cardiovascular diseases, stroke and high blood pressure.   

To improve cardiovascular fitness, it takes a minimum of 6 weeks of regular training to see a 
noticeable change. Less fit individuals tend to see improvement quicker.  More active individuals 
typically need more time to see progress.    

Cardiovascular fitness is best improved by exercise types which use large muscle groups. Such 
activities include walking, jogging, swimming, rowing, skating, cross-country skiing and cycling.   

About the Polar Keeps U Fit Cardiovascular Program 

Keeps U Fit -program is an exercise prescription tool, which allows creating a personal exercise 
program for aerobic fitness maintenance or improvement. The improvement has two alternatives: 
improve and maximize. The personalized program takes into account current fitness level and 
how many times per week the client wants to exercise. Based on these values, daily and weekly 
exercise targets are created. The program provides weekly calories and the number and duration 
of weekly exercises. In addition, calories, duration and intensity are provided for individual 
exercise sessions.  

To get the individual exercise program, start by measuring the client's fitness level (VO2max or 
Polar OwnIndex). Select the program target: maintain, improve or maximize your fitness. Target 
selection affects the recommended weekly exercise number, intensity and duration. Easy and 
hard exercise sessions alternate in the program to minimize the risk of fatigue and overtraining. 

Goals:  

Program goals are maintain (about 1.5hr/week), improve (about 3hr/week) and maximize (about 
4.5hr/week) fitness. These all are related to the user's current fitness level (VO2max or OwnIndex). 
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Maintain: Select Maintain if the target is to maintain the client's current fitness level. If they have 
not exercised recently, maintain is a good start for them and may even improve their fitness. The 
program recommends that the client exercises approximately fore one and a half hours per week 
with light to moderate intensity, divided into two to three exercise sessions. The average duration 
of one exercise session is 30-45min. 

Improve: Select Improve if the target is to improve the client's current fitness level and if they are 
able to exercise regularly. The program recommends that the client exercises for approximately 
three hours a week divided into three to five exercise sessions and by varying light, moderate and 
hard intensity. The average duration of one exercise session is 40-60min. 

Maximize: Select Maximize if the target is to maximize the client's current fitness level, if they 
have been exercising regularly for at least 10-12 weeks and exercising nearly every day is not a 
problem for them. The program recommends that the client exercises for approximately five hours 
a week, divided into four to six exercise sessions varying light, moderate and hard intensity. This 
goal will include the highest number of high intensity sessions. The average duration of one 
exercise session is 45-70min. 

Frequency, duration and intensity 

In order to understand the default program and adjust the program the user needs to understand 
the meaning and interactions between the frequency, duration and training intensity. Regularity is 
the key. More often is better than less often. However, too often may lead to exhaustion and 
increase the risk of injuries. It is generally known that 1-2 times weekly is not enough to improve; 
3 or more times weekly is needed for this target. It is advised to start with a warm-up and close 
with a cool-down in every exercise session. More energy is expended during a longer session 
when compared to a shorter session with the same intensity. This is the key in the structure of 
exercise sessions and their naming. The higher the intensity, the more energy is expended. The 
high intensity sessions are shorter in duration than others to avoid overstrain and to ensure 
maximal adherence to the program. 

HR Zones:  

In the Keeps U Fit Own Workout program there are 3 different heart rate zone targets for the 
weekly exercises. The program displays the time targeted in each of the zones. Most exercises 
are in the moderate zone. The more you exercise, the wider the variation in HR zones. 

Light 60-70% HRmax         Aerobic endurance 

Moderate 70-80% HRmax  Aerobic power 

Hard 80-90% HRmax          Aerobic stamina, anaerobic power 

Exercise sessions:  
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The program gives suggestions: e.g. Short1, Normal2, Long1, which depend on the number of 
exercise session selected. The order of exercises is decided by the program to optimize results. 

The length of each session is defined by the target for the program (maintain, improve, maximize) 
and the number of exercise sessions per week (range from 1-6 sessions). Short exercise session 
is shorter than Normal, which is shorter than Long. 

Polar Keeps U Fit -program includes weekly exercise volume in terms of frequency (number of 
sessions), total duration (hours:minutes) and energy expenditure. The harder the intensity, the 
shorter the duration. Short sessions are typically "hard" (80-90 % HRmax) in intensity, Normal 
sessions "moderate" (70-80 % HRmax) and Long sessions "light" (60-70 % HRmax).  

Exercise sessions in the program are arranged so that there are no successive similar sessions 
(hard or light ones) and that there are several days between the hard sessions. This helps to 
carry out the program, ensures needed recovery time and helps to avoid overreaching and 
becoming tired. 

About the Polar windlink 

The BodyAgeTM System comes with a Polar WindLinkTM which transfers online real-time heart rate 
recording to the computer.  

WindLink receiver is used with the cardiovascular protocols. If the client is wearing a Polar 
WearLink W.I.N.D. transmitter, an electrocardiogram signal will be sent directly to the computer 
via the WindLink receiver.  The computer uses a sophisticated averaging algorithm to ensure an 
accurate and stable heart rate reading.   

Applying the Training Computer 

Thoroughly clean the subject's skin so that oil and dirt are removed.  Wipe with alcohol if 
necessary.  Moisten the inside of the heart monitor belt (preferably with electrode jelly) and 
securely fasten the belt below the pectoral muscles.  The logo on the middle of the belt must be 
centered on the lower sternum.  Instruct the client to keep the upper body erect without shoulders 
slouching. 

NOTE: Transmitter belt must completely contact the skin below the pectoral muscles. Chest hair 
or underwire bras may interfere with this. 

Interference 

It is important to control environmental conditions that may interfere heart rate transmission.  You 
may experience interference in small crowded areas, especially with a lot of electronic equipment. 
 Also, be sure that there are no additional transmitters or cell phones being utilized near (within 
10-15 feet) of the receiver. Sometimes florescent lights and movement of the receiver can cause 
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significant interference.  It is important to have the receiver mounted to prevent movement during 
the tests. 

Assembling the Polar BodyAge System 

Interface Connections 

Noting that the interface box is secured to the top of the computer with a velcro strip, connect the 
following peripherals to the box: 

Skinfold 
Calipers 

 

Platform 

 

Heart Rate 
Cable/RPM 
cable 
interface  

 

ROM 
(Range of 
Motion) 
Unit 

 

 

Printer 

Plug the power into the printer. 
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Main Unit Power 

Using the main power cable, plug the system into a wall outlet.  Power is applied to the system 
via the power entry module located on the left rear of the cart. 

1. Plug power 
cable into a wall 
outlet. 

2. Always use 
the system main 
power switch to 
turn the entire 
system on and 
off.  On is “|” 
and off is “o”. 

 

Power Entry Module Information 

The power entry module is a switchable power supply between 110v (USA and Canada) and 
230v (European).  The unit is shipped from the factory with the 230v selected.   

Fuse Types:   

For the 110Volt (USA and Canada), the fuses are  ¼ x 1 ¼” 250Volt, 2 Amps, Slow Blow Fuses. 

For the 230Volt (European), the fuses are 5mm x 20mm, 250Volt, 3.0-3.5 Amp Slow Blow Fuses. 

Replacing the Fuses: 
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• To replace the fuses, make sure the power 
is unplugged and completely disconnected 
from the power.   

• Next, using a small flathead screwdriver, 
pry the cover open on the far right side. 

• Carefully pry the fuses out and insert the 
new fuses. 

• Close the cover, insert the power cord and 
turn the power switch on “|”. 

 

Platform/Scale 

• Screw in the eyebolt on 
the scale strap assembly 
into the top of the 
platform. Make sure it is 
tightened all the way. 

• Attach the “C” connector 
on the strength strap 
assembly to the strength 
handle. Make sure it is 
tightened all the way. 

• Check the strap for any 
wear or defects before 
each use, as this can 
cause injury to the client 
being tested on the 
biceps strength test.  

 

Ergofit Ergometer 

The ErgoFit bike needs to be connected to the Polar BodyAge® System with a null modem cable. 
 This cable plugs into the back bottom of the ErgoFit ergometer. Plug the other end of the serial 
cable into an available serial port in the back of the CPU. 

Note: The serial cable is a 9-pin null-modem Cable. You must use a null-modem cable or a null-
model adaptor for the Ergofit Ergometer to function properly with the Polar BodyAge® System. 
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1. Power cable for 
the Ergofit. 

2. Plug the null 
modem serial 
cable into the 
Ergofit serial plug. 

 

Tanita BF-350 or BC-418 

The Tanita BF-350 or BC-418 is a unit for measuring bioimpedance using the Polar BodyAge® 
System. It interfaces to the system with a serial cable.   

Note: The serial cable is a 9-pin null-modem cable. You must use a null-modem cable or a null-
model adaptor for the Tanita BF-350 to function properly with the system. 

Plug the 
power 
cord 
into a 
220v 
power 
outlet. 

Plug the 
serial 
cable 
into the 
Tanita 
BF-350 
or BC-
418 as 
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shown 
here. 

Plug the 
other 
end of 
the 
serial 
cable 
into 
Device 
Port 1 
or 
Device 
Port 2 
on the 
TF700iu 
box. 

 

Polar Sonic InterfaceTM

The optional Polar Sonic InterfaceTM uses the speaker and microphone ports on your PC to send 
and receive information to Polar training computers (F11, F6, F4 and all Polar UpLink enabled 
computers).   

 

Installation Instructions 

Plug the GREEN Polar Sonic 
Interface cable into the Speaker 
port on the computer. 

Alternately, This can be plugged 
into a headphone jack on the 
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computer 

Plug the PINK Sonic Interface 
cable into the Microphone port on 
the computer. 

 

If you want to use your existing speakers and microphone on your PC, use the included “Y” 
splitters. If you have your PC Speakers enabled using the “Y” Splitter, you will hear a sound from 
your PC speakers when setting the training computer. There is never sound when uploading files 
from the training computer to the PC. You will need to adjust the speaker and microphone volume 
for proper operation, depending on the noise of your environment and computer sound card type.  

1. To your 
microphone 

 

2. To your 
speakers 

 

 

Bicep Strength 

Bicep strength is measured from an isometric contraction against the unique 'four load cell' 
platform.  Strength is calculated by the average resistance over the last three seconds of a five 
second lift. 

Using Bicep Strength 

Click on Bicep Strength link from the Strength & Flexibility section of Fitness Assessments. 
You will be prompted to initialize the scale.   
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1. Instruct the client to stand on the platform with his/her feet shoulder-width apart holding the bar 
at their side. Note! Do not pull on bar. 

2. Adjust the strap so that the client’s forearms are 90 degrees to the torso.   

3. Click Continue. The bicep strength test screen appears.   
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4. Once the client is ready, click the Start Trial 1 button in the lower part of your screen.  

• A countdown from 0:03 to 0:01 will begin immediately. This prepares the client for 
the start of the test.  At this point, the client should be instructed to start the five 
second lift.  DO NOT JERK.   

• At the end of the lift, the value lifted will appear in the lower part of your screen. 

• A 30 second timer will begin after the first two trials to give the client a rest in 
between.  

• The final result will reflect the best lift. 

5. Click OK to save the data and return to the main screen.  

Bioimpedance 

Bioelectrical Impedance Analysis technique (BIA) is based on the fact that lean tissues have a 
high water and electrolyte content, and thus provide a good electrical pathway.  Fat mass 
contains a lower percentage of body water, and thus is a poor conductor of the electrical signal. 
 By inducing a low energy, high frequency, electrical signal (Tanita BF-350 and BC-418 use 50 
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kHz, 500 microamp), a measurement of the baseline resistance to the flow of electrical current 
can be made.  This current is passed though the anterior electrode on the scale platform, and the 
voltage drop is then measured on the posterior electrode. The resistance measurement relates 
directly to the volume of the conductor, which is used to determine total body water, lean body 
mass, and finally, fat mass.  Percent body fat is calculated using a formula combining impedance 
and weight measurements with height, gender, and age information.   

In order to obtain the most accurate results from your bioimpedance device, ensure the following 
conditions are met:  

• No alcohol 48 hours before the test 

• Avoid intense exercise 12 hours before the test 

• Avoid eating or drinking (especially caffeinated products) 4 hrs before the test 

• Empty bladder 30 minutes before test  

• Avoid all diuretics for 7 days before test (only if possible) 

• Measure in bare feet. Individuals wearing thin nylons will receive accurate results if a 
drop of liquid (saline solution, water) is placed in the center of each electrode.     

Athlete Mode 

There are physiological differences between standard adults and very athletic individuals.  The 
actual impedance reading will be the same in both the standard and athletic modes, however, a 
different algorithm validated in athletic populations, must be used when interpreting this data. 
 Thus, the percent body fat reported for an athletic individual measured in the standard mode (or 
vice versa) is incorrect.  

When you go into the testing screen for Bioimpedance (see Using Bioimpedance) you will have 
the option to select ’Athlete’ if the person being measured is an athlete.  The guidelines for 
selecting 'Athlete’ are as follows:  

• Individuals over the age of 16 who exercise at least 10 hours a week consistently for a 
period of at least 6 months.  

• Individuals who have a resting heart rate of approximately 60 beats per minute or less.  

• This mode includes people who have been very fit for years, but currently exercise less 
than 10 hours per week.  

Bioimpedance Measurement 
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Click on Bioimpedance link from the Body Composition section of Fitness Assessments to 
bring up the bioimpedance on-line measurement screen.   

 

Follow the directions shown on the screen to carry out the bioimpedance measurement. 

The last screen of the bioimpedance measurement wizard will show the results in a format of a 
line graph and a pie chart. 
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NOTE: If you have selected the default to use the bioimpedance device for weight measurement 
and you have not taken the height of your client, you will be prompted with a screen to enter 
height before entering the bioimpedance measurement. Type it in and select Continue. 

If you have not selected the default to use the bioimpedance device for weight measurement and 
you have not taken the client's height and weight, you will be prompted with the message "Height 
and Weight must be accessed". Click OK after entering the height and weight of the client and 
then click on the Bioimpedance link. 

 

Blood Chemistries 

Healthy adults should have their blood cholesterol and triglyceride levels measured at least once 
every three years.  Ideally, an individual should have their blood chemistries measured annually. 
If the client does not know their blood chemistry levels, contact a health care provider.  Make an 
appointment to have blood samples analyzed and document the results for total cholesterol, LDL 
cholesterol, HDL cholesterol, triglycerides, and glucose. 
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Click on Blood Chemistries link from the Biometrics section of Fitness Assessments to view 
the screen for entering the blood chemistries.  

 

Start by placing the cursor on the Total Cholesterol text box and type in the value.   

To continue to the next text box, press the TAB key.    

Viewing the Blood Chemistries Results 

There are two ways to view the classification of the blood chemistry values: 

1. As you enter the values for blood chemistries, a red line will run across the bar graph on the 
right of the text box and the classification will be highlighted in yellow.    

2. Preview or print a Graphical Summary or Personal Profile Report.   
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Blood pressure 

Follow these suggestions to obtain a correct measurement: 

• Instruct the client to rest and relax for at least five (5) minutes before the blood pressure is 
taken. 

• Take the blood pressure measurement on the right arm. 

• When repeating measurements, release the cuff pressure completely to remove its constriction 
to the arm.  Elevate the arm to make certain of normal blood circulation before making another 
measurement. 

• Repeated deep breaths, talking, coughing or sneezing may affect the reading.  Relax and 
remain still and quiet during each blood pressure measurement. 

• A rolled-up sleeve may constrict blood flow through the arm.  Also, putting all or part of the cuff 
on top of a sleeve may affect the accuracy of the reading. 

• Do not measure blood pressure after exercise. 

• Instruct the client to urinate prior to measuring blood pressure.  Blood pressure may be higher 
when a person has to urinate. 

• Instruct the client to refrain from drinking caffeinated drinks prior to measuring blood pressure 
(coffee, tea, coke, etc.). 

• Instruct the client to refrain from smoking prior to measuring blood pressure. 

• The arm cuff must be the correct length and width for the client's arm.  Use the appropriate cuff 
size based on circumference of bicep: Small 18-26cm, Regular 26-35cm or Large 32-42cm. 

Blood Pressure Measurement 

Click on Blood Pressure link from the Biometrics section of Fitness Assessments to view the 
screen for entering blood pressure.  
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Blood pressure can be entered either on-line or manually. 

On-Line Blood Pressure Measurement 

To measure blood pressure on-line using the 700IU blood pressure unit, follow the exact 
instructions displayed on the screen and click on the Measure button.  After blood pressure has 
been measured, the results will be automatically displayed in the lower portion of the screen. 

Manual Entry of Blood Pressure 

To enter an individual's blood pressure results manually, do as follows: 

1. Use the mouse to point and click on the Systolic input field in the lower section of your screen. 
The blinking cursor will appear.  

2. Use the keyboard to manually enter the systolic measurement and then press the enter key. 
The cursor will now be blinking within the Diastolic input field.   

3. Enter the diastolic measurement and press the enter key. The cursor will be placed in the 
Pulse input field.  

4. Enter the pulse measurement and press the enter key. 
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5. Click OK to save the result and return to the main screen. 

Fluctuations in Blood Pressure 

Unlike body temperature, blood pressure is not constant. Acute regulation of blood pressure is 
achieved by the sympathetic nervous system, while long-term regulation of blood pressure is 
primarily a function of the kidneys. The kidneys regulate blood pressure by their control of blood 
volume.  Because blood pressure can be influenced by several systemic factors, it does not 
remain constant.  In general, any circumstance leading to an increase of pulse rate tends to 
cause blood pressure to rise. The following can influence blood pressure measurements: 

Exercise  --  Exercise elevates blood pressure and heart rate.  Always measure blood pressure 
and resting heart rate before you do the fitness assessment.  Make sure to ask the client if he/she 
has walked briskly or exerted themselves in any way prior to their fitness assessment. 

Medications  --  There are various medications that elevate blood pressure, including some cold 
medicines.  Many medications are used to decrease blood pressure in those individuals that have 
been diagnosed with high blood pressure. 

Smoking  --  Nicotine elevates blood pressure.  Ask your clients not to smoke prior to the 
assessment if possible. 

Caffeine  --  Caffeine elevates blood pressure.  Ask your clients to refrain from ingesting caffeine 
until after the assessment. 

About your Blood Pressure Unit 

Your 700iu Blood Pressure unit uses a state of the art technology in measuring blood pressure - a 
variation of the oscillometric procedure for measuring blood pressure. The unit does not listen to 
sounds, but instead detects the blood pressure through a sensor that responds to changes in the 
pressure in the arm cuff. This method is very sensitive and accurate. Since this unit does not 
depend on sound waves, it is not affected by false noises, but is sensitive to movement and the 
flexing of the biceps. 

Body Composition Settings 

Select System Settings > Test Environment. Choose Body Composition from the Test 
Environment Settings view. 
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In Body Composition you can set a bioimpedance device to be interactive with the Polar 
BodyAge® System.    

1. First select your device from the drop-down list next to Bioimpedance Device. 

2. Select the Serial Port that the device is attached to (it can either attach to an additional serial 
port in your computer or it can be connected to Device Port 1 or Device Port 2 on the 700iu 
box).   

If you want use the bioimpedance device to calculate weight when you do a Bioimpedance body 
composition test, then you will need to check the check box next to Use Bioimpedance Device 
for weight measurement.  

NOTE: If you are using bioimpedance without a bioimpedance device attached to the system, you 
must select None from the drop-down list next to Bioimpedance Device, or the correct screen 
will not appear when you click on Bioimpedance from the main screen. 

Body Mass Index (BMI) 

Body Mass Index is calculated as an individual's weight divided by height squared: kg/m2. The 
Body Mass Index results are broken down in the following manner: 

Less than 18.5 Underweight 

18.5 - 24.9 Normal 
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25.0 - 29.9 Overweight 

30.0 or Greater Obese 

About Obesity (Related to BMI) 

Obesity-related health risks include high blood pressure, increased blood fats and cholesterol, 
heart disease, stroke, diabetes and certain cancers.  Obesity can reduce life expectancy and 
threaten quality of life.  Health risks may multiply or become more severe as your BMI increases. 

Overweight, but not Over Fat 

Athletes with a large mass of muscle (bodybuilders, weight lifters, heavier wrestlers, football 
players, etc.) may be classified as overweight according to the BMI classifications, but they could 
still be in the healthy range of body composition.  This is the drawback of the BMI classification 
scale.  It is recommend that you use a means of measuring body composition when assessing 
athletes with large amounts of muscle mass.  

Calibrating the Load Platform 

1. Select System Settings > Calibrations. 

 

2. Select Load Platform from the drop-down box. Click Calibrate. 
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3. Make sure there is nothing on the scale. Click Next. 

 

4. Have someone step on the scale that knows his or her exact weight.  Have them measure their 
weight on a scale that is known to be accurate (i.e. Triple beam balance scale).  Use that 
measurement when you enter the value while they are standing on the Polar scale. Click Next. 
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5. Make sure the current calibration reading is between 0.4-2.0 

 

*It is best to use a person that knows his or her exact weight and weighs between 68 and 86 kg 
or 150 and 189 lbs to calibrate the scale, as weight plates are not always the exact weight as 
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printed on them. Make sure the person has the same clothing on he or she was wearing when 
measuring and calibrating.  The weight scale is accurate to within 0.2 kg.   

**Calibration result will be more accurate if there are two persons calibrating; one standing on the 
platform and the other typing the weight. 

Calibrating On-line Peripherals 

When initially setting up your Polar BodyAge® System and each time the Polar BodyAge® 
System is transported or every two months, it is recommended to calibrate the skinfold calipers, 
the load platform (which calibrates both scale and biceps strength test) and the range of motion 
unit to ensure accurate results.  

Select System Settings > Calibrations. Select the Calibration Type from the drop-down box. 
You will be prompted with instructions regarding how to calibrate the equipment. For further 
instructions, see the following sections:   

Calibrating the Skinfold Calipers

Calibrating the Load Platform

Calibrating the Range of Motion

  

Calibrating the Range of Motion 

1. Select System Settings > Calibrations. 

 

2. Select Range of Motion from the drop-down box. Click Calibrate. 
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3. Make sure the handle is in the handle clips. Click Next. 

 

4. Pull the handle out exactly 30 cm / 11.8 inches. Click Next. 
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5. Make sure the current calibration reading is between 0.35-0.55. 

 

* It is recommended that you have a 30 cm / 11.8 inches ruler when performing this calibration. 
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Note: It is easier and typically more accurate to use two people when calibrating the range of 
motion. 

WARNING: Use care when pulling out and returning the handle.  Do not pull the handle out too 
far and when a client has finished the test be careful they do not let go of the handle and let it 
snap back. This is a delicate measurement device. 

Calibrating the Skinfold Calibers 

1. Select System Settings > Calibrations.  

 

2. Select Calipers from the drop-down box. Click Calibrate. 

 

3. Make sure the caliper jaws are in the closed position. Click Next. 
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4. If using the metal dowel provided with the system, place it lengthwise between the calipers as 
shown. The measurement of the dowel is exactly 25.4 (that is the default value). If you are 
measuring something else than the dowel, enter the result in the text box. Click Next. 

 

5. Make sure the current calibration reading is between 14.0-17.5 
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Cardio 5 Zone settings 

Select System Settings > Test Environment.. Choose Cardio 5 zone from the Test 
Environment Settings view. 

In this view you can define the heart rate zones that will be applied in 5 Zone training programs. 
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You can define two separate heart rate zones based on Maximum heart rate and Anaerobic 
threshold. 

First select Maximum heart rate or Anaerobic threshold from the drop-down list. Then define 
the lower limit for each zone. The upper limits will adjust automatically.   

 

Cardiovascular Settings 

Select System Settings > Test Environment. Choose Cardiovascular from the Test 
Environment Settings view. 

 

Enter the following information if you are doing cardiovascular testing with a cardio device (i.e. 
ergometer or treadmill). 

Select the correct device from the drop-down list next to Cardio Device.   

Select the Heart Rate Device that you will be using for the cardiovascular testing: WindLink, 
Magnum Upright Ergometer or Polar Interface box. 

Attach the cardio device directly to the computer and select the serial port that it is connected to 
from the drop-down list next to Serial Port.  

Enter the following information if you are taking a cardio test without a cardio device attached to 
the BodyAge System. 
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Select None from the drop-down list next to Cardio Device, or the test will not work properly.  

Select the Heart Rate Device that will be used during cardiovascular tests: WindLink or Polar 
Interface box. 

Cooper 12 Minutes Run/Walk 

The client is instructed to run as far as possible in 12 minutes on a flat, uninterrupted track that 
has been measured.  The required information is the distance. 

Click on Cooper 12 Minutes Run/Walk link from the Cardiovascular section of Fitness 
Assessments to enter the client's test result. The test's input box appears. 

 

Enter the required information and press OK to save. 

Crunch 

All sit-ups, including the bent-knee type, utilize the hip flexor muscles to raise the trunk.  The hip 
flexors can be eliminated, and abdominal muscle endurance can be evaluated through the use of 
the crunch test. 

1. Have the client lay on their back, on a mat, with the knees bent to 90 degrees. 

2. The client should extend the arms, palms down and by the sides, so that the finger tips of 
both hands touch a strip of tape perpendicular to the body at just below hip level. 

3. Two additional strips of tape are placed parallel to the first two, 3.5 inches (8.9cm) further 
toward the feet. 

4. The client should curl up, sliding the fingertips along the mat until they touch the second 
set of tape strips, and then return to the starting position. The client's head does not need 
to come back to touch the mat as long as the shoulders do. 
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The crunch is slow, controlled and continuous. Only the head and shoulder blades leave the floor. 
The upper body moves through only 30 degrees. 

The client performs as many crunches as possible in one minute. 

How to Use the Crunch Test 

Click on Crunch link from the Strength & Flexibility section of Fitness Assessments to bring 
up the crunch test screen. 

You will be given a set of instructions.  

 

After reading the instructions, click Continue. The following screen appears: 
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When the client is ready to begin the test, click Start. The timer will count down from one minute. 
  

To count the number of full repetitions, click an alphanumeric key on the keyboard each time a 
repetition is completed.   

When the minute is up, the timer will automatically stop and beep to indicate that the test is over.  

Click OK to save the data and return to the main screen.  

 

 

Cycle Ergometer 

After creating a new record or opening an existing record for a client, their height and weight must 
be recorded before the VO2max test can be performed. 

1. Click on the link of the chosen Ergometer VO2max test from the Cardiovascular section of 
Fitness Assessments. 
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2.  The VO2max test screen appears. Verify that the heart rate is being transmitted correctly by 
looking at value next to the line graph on the top.  

 

 

3. Click Start to activate the test.  A physical activity rating questionnaire appears: 
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4. Select the alternative that best represents the person taking the test. Click Next. 
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5. The heart rate of the client that is taking the test should appear in the top box. Instruct the 
client to begin pedaling. The RPM’s will show up in the lower box  (they will only appear if the bike 
is connected to the BodyAge system). Next will become activated when a heart rate is 
transmitted.  Click Next to begin the test. 

6. Instruct your client to maintain RPM at 60-80. When the test is complete, the data will be 
displayed.  

7. Select Print to print the data and the graph. Select OK to save the data and return to the main 
screen.  

About the WHO Submax Test 

Protocol Overview: 

• Test includes 3 to 4, 4 minute stages. 

• Test starts with 4 min warm-up (included as stage 1). 

• Target to reach 80% VO2max (about 85-88% HRmax) 
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• Selection of workloads is made based on a percentage of estimated VO2max prediction by 
Jackson et al. 1990 Non-Exercise equation.  

• VO2max and Max Workload (WATTS) is based on a regression equation that uses  age-predicted 
HRmax (220-age) and the stage Watts and steady state HR.  

Protocol Stage Progression: 

Stage 1: 38% VO2max (based on Non-Exercise Prediction) 

Stage 2: 52% VO2max (based on Non-Exercise Prediction) 

Stage 3: 65% VO2max (based on Non-Exercise Prediction) 

Stage 4: 78% VO2max (based on Non-Exercise Prediction) 

About the YMCA Submax Test 

Protocol Overview: 

The YMCA bike protocol is a single branching protocol. The number of stages and workloads 
depends on the heart rate after the first stage.  If the heart rates are: 

<80 bpm, then the second stage is 2.5 kp 

80-89 bpm, then the second stage is 2.0 kp 

90-100 bpm, then the second stage is 1.5 kp 

>100 bpm, then the second stage is 1.0 kp 

The following stages increase by 5 kp each stage independent of the heart rate response.  

About the Pollock Submax Test 

Protocol Overview: 

The Pollock bike ergometer protocol is a multiple branching protocol and a more difficult protocol 
than the YMCA. Therefore, it is recommended for more active individuals. 

The first workload is 1.0 kp.  (1.0 kp is equal to 50 watts)  

If after the first stage the heart rates are <90, then second stage is 3.0 kp 

If after second stage heart rates are: 
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<120, third stage = 4.5 kp 

120-135, third stage = 4.0 kp 

>135, third stage = 3.5 kp 

If after the first stage the heart rates are 90-105, then second stage is 2.5 kp 

If after second stage heart rates are: 

<120, third stage = 4.0 kp 

120-135, third stage = 3.5 kp 

>135, third stage = 3.0 kp 

If after the first stage the heart rates are >105, then second stage is 2.0 kp 

If after second stage heart rates are: 

<120, third stage = 3.5 kp 

120-135, third stage = 3.0 kp 

>135, third stage = 2.5 kp 

Define Form Letters 

To define a form letter, which you can attach to batch reports, select Preferences > Define Form 
Letters.  

The following view will open:  
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Select the language from the drop-down list and open the Corporate Letter template. 
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In this view you can create new content for the letter. When you are finished, select File > Save. 
Rename the file and click OK. The form letter will be added to the form letter options in Batch 
Printing window. 
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Direct Value Body fat percent 

Direct value can be used to enter a percent body fat measurement obtained by another method 
such as hydrostatic weighing or Dual X-Ray Absorption.  

Click on Direct Value Body Fat Percent link from the Body Composition section of Fitness 
Assessments to bring up the screen for entering a direct value. 
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The curser will be blinking within the input box. Enter the required information and press OK to 
save. 

Direct Value VO2MAX

If your client has had their VO2max tested directly in a lab setting, you can enter that value in 
BodyAge System.  

Click on Direct Value VO2max link from the Cardiovascular section of Fitness Assessments to 
enter a direct value.  

 

The curser will be blinking within the input box. Enter the value and press OK to save. 
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Downloading Files 

Downloading Files Using the Polar FlowLink 

Use Polar Flowlink to download training files from Polar FT7, FT40, FT60, FT80 and RS300X 
training computers. 

1. Place the training computer on the FlowLink. Click Download File in Training Progress view. 

 

2. The following window appears: 

 

3. Click Download to start downloading the training files. The files will be listed in this view.  

4. To save a file, highlight the file and click Save. To save all files, click Save All. 

Downloading Files Using the Polar IrDA USB Adapter 
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Optional Polar IrDA USB Adapter is required to download files from RS400, RS800 and 
RS800CX training computers. 

1. Place the training computer in front of the infrared window on the Polar IrDA USB Adapter or 
on the computer or other IrDA compatible infrared adapter. 

 

2. Click Download File in Training Progress view. 

 

2. The following window appears: 
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3. Click Download to start downloading the training files. The files will be listed in this view.  

4. To save a file, highlight the file and click Save. To save all files, click Save All. 

Downloading Files Using the Polar Sonic Interface 

Optional Polar Sonic InterfaceTM  is required to download files from F11, F6, F4 or other Polar 
UpLink enabled training computers. 

The Polar Sonic InterfaceTM  uses the speaker and microphone ports on your PC to send and 
receive information to Polar training computers. For installation instructions, see Polar Sonic 
Interface section in Assembling the Polar Bodyage System. 

1. Place the training computer on the Sonic Interface. Click Download File in Training Progress 
view. 

 

2. The following window appears: 
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3. Click Download to start downloading the training files. The files will be listed in this view.  

4. To save a file, highlight the file and click Save. To save all files, click Save All. 

 

 

Edit Additional Information 

You can add new question fields to be shown in Additional Client Information within Client 
Information in Preferences > Edit Additional Client Information. 

For example if you want to know what sport your client plays or if they follow a specific diet (i.e. 
vegetarian), you can make a question field and add a drop-down list of selections later in 
Additional Client Information.  

To add multi-answer questions to Additional Client Information, select Preferences > Edit 
Additional Client Information. The following window appears:  
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Click New to enable the text field. Type in a new question. 

 

By clicking Save, the question or Field Group will appear in the larger box field. 

By clicking on New, you start the process over again. 
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By highlighting the question and selecting Edit, you can change the question. 

By clicking Close, the question field will appear on the Additional Information tab of Client 
Information: 

 

Email settings 

Select Test Environment > System Settings. Choose Email from the Test Environment 
Settings view. 
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In Email view, you can enter the email account settings for emailing directly from the software to 
the customers. Check your details with e-mail service provider. 

General Settings 

Select System Settings > Test Environment. Choose General from the Test Environment 
Settings view. 

 

In General you can enter the following information: 

1. Company/Club name. 

2. Facility name: The facility name will appear on the lower right hand corner of the reports.   

3. Default Gender:  Select Male or Female. 

4. Polar Interface Port: This is the port that you have the 700iu box plugged into. The port will be 
automatically detected if you click on Detect.  

5. Language 

6. Application Options  

• Display the last person tested when the program starts: This check box allows you to 
protect the privacy of your clients by displaying a blank screen (rather than the last record 
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visited) each time you open the program.  To activate the privacy feature, uncheck this 
box. 

• Include BMI in reports: You can include or exclude the Body Mass Index (BMI) from the 
reports if you check the box or leave it unchecked. 

• Require login: If you want login to be required, check this box. 

7. Units 

• Measurement Units: Select Imperial or Metric 

• Blood Chemistry Units: Select mg/dl or mmol/l 

8. Displayed Client Information  

Each time you add a new client to the BodyAge System database, a client information box will 
appear. Include or exclude the following information from the client information by checking the 
box or leaving it unchecked. 

• Show Middle Name Field 

• Show Race Field 

• Show Country Field 

• Show City Field 

• Show State Field 

• Show Postal/zip Code Field 

Girth 

Click on Girth link from the Biometrics section of Fitness Assessments to view the screen for 
entering the client's girth measurements. 

Enter the girth measurements manually and press OK to save.  
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Guidelines for Cardiovascular Testing 

It is the tester's responsibility to administer a safe test.  

***CAUTION:  An exercise test should be immediately TERMINATED if any of the following 
indications occur: 

• Onset of angina or angina-like symptoms 

• Significant drop (20mm Hg) in systolic blood pressure 

• Failure of systolic blood pressure to rise with increasing intensity 

• Excessive rise in blood pressure:  Systolic >260 or Diastolic >115 
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• Signs of poor perfusion:  Dizziness, cyanosis, nausea, cold skin 

• Failure of heart rate to increase with increasing intensity 

• Noticeable change in heart rhythm 

• Client requests to stop 

• Physical or verbal manifestations of severe fatigue 

• Failure of the testing equipment 

Heart Disease Risk Factors 

Age 

Men > 45 years; women > 55 or premature menopause without estrogen replacement therapy. 

Family History 

Myocardial Infarction or sudden death before 55 years of age in father or other male first-degree 
relative, or before 65 years of age in mother or other female first-degree relative. 

Cigarette Smoking 

Currently a smoker 

Hypertension 

Blood Pressure > or = 140/90 mm Hg, confirmed by measurements on at least two separate 
occasions, or on antihypertensive medication. 

Cholesterol 

Total serum cholesterol > 200 mg/dL or HDL <35 mg/dL 

Diabetes Mellitus 

Persons with insulin dependent diabetes mellitus (IDDM) who are > 30 years of age, or have had 
IDDM for more than 15 years, and persons with non-insulin dependent diabetes mellitus (NIDDM) 
who are > 35 years of age should be classified as patients with disease. 

Sedentary Lifestyle/Physical Inactivity 
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Persons comprising the least active 25% of the physical inactivity population as defined by the 
combination of sedentary jobs involving sitting for a large part of the day and no regular exercise 
or active recreational pursuits.  Obesity is not listed as an independent positive risk factor 
because its effects are exerted through other risk factors. 

Height/Weight 

Click on Height/Weight link from the Biometrics section of Fitness Assessments to view the 
screen for entering the client's height and weight. The cursor will be first blinking within the blank 
height field.   

 

How to Measure Height 

You can enter height in two ways: 

1. You can enter the exact height in centimeters or inches (depending on the measurement unit 
setting) using the number keys on your keyboard. If you want to change the measurement unit, 
see General Settings for instructions. 

2. Use the mouse to point to the height scale's slider needle. Holding down the mouse button, 
drag the slider up or down to the client's height.   
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How to Measure Weight 

To ensure accuracy of measuring the weight of a client, you should make sure that their shoes 
are off and they are in light clothing.  If they are being retested for weight, then have them wear 
similar clothing as they did last time they got measured. 

NOTE: If you are using bioimpedance to measure weight, see Body Composition Bioimpedance 
for more information. 

To measure weight online, click on the Measure button, tell the client to step on the scale and 
wait until the green progress bar is complete.  After weight has been measured, the results are 
automatically displayed on the weight dial and within the weight text box. 

To manually enter a client's weight, use the mouse to point and click within the weight input box 
and use the number keys on your keyboard to enter the client's known weight.   

To show the results for body mass index, press Show BMI. See Body Mass Index (BMI) for more 
information. 

To exit Height/Weight, use the mouse to point and click on the OK button in the lower right of the 
screen. The data will be saved. 

 

Import/Export 

The Import/Export feature is designed for mass import and export of data.   

Import 

The data can be imported in two different ways. 

1. You can import demographic information and organizational level information in an XML file 
following a strict format (see the xml schema and/or xml import example that were included in the 
installation). When importing multiple files or importing often, this is the optimal method. Select 
System Settings > Test Environment. Choose Import / Export from the Test Environment 
Settings view. 
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Checking the check box that says Always Import Demographic Information At Start Of 
Program and selecting a folder to browse to will force the program to check the chosen folder to 
import each file in the folder. After each file is imported a folder called Imported will be created in 
this folder. All files imported will be placed in this folder. At the application start the client tree will 
be updated with the information imported. 

2. For importing a single file occasionally, select Import Clients from the File menu. The 
following screen appears:  
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Browse to, and select the file (.txt or .csv) to be imported. See an example of an import file in a txt 
format below: 

 

Note: Write the date of birth in the mm/dd/yyyy format. 

Click Next. The following screen appears:  

152 



Polar BodyAge System SW Help 

 

Select the filed separator type and the text qualifiers used in the import file from the drop-down 
lists.  

To use the first row data for field names, check the box next to Use first row for field names. If 
you check this box, the first row data will not be imported.  

Click Next to continue. 
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Match the import fields to corresponding fields in the software, if required. Click on the software 
field and select the correct field from the drop-down list. Click Next to continue. 
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If there is an error in the imported data, the incorrect data is written in red. Click on the text field to 
activate the field and type in the valid data.  

Click Next to start importing the file. The next screen shows the number of imported and updated 
clients. 
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Export 

You can export assessment information for each client. If the client has multiple assessments, all 
will show up in the XML file. 

The data can be exported in two different ways. 

1. To export every time the application closes, select System Settings > Test Environment. 
 Choose Import / Export from the Test Environment Settings view. 
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Checking the check box that says Always Export Assessment Information At Close Of 
Program will force the program to export an XML document at close. If you check the box, 
browse to the folder you want the data to be exported to 

Choose whether you want to export the test results of All Clients, or of a specific group by Using 
Query. If you choose to use the query, select an existing query from the drop-down box, or click 

 to create a query. For instructions on creating the query, see Query Builder. 

2. To export occasionally, select Preferences > Advanced. Choose Export Records .  
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Browse to the folder you want the data to be exported to. Give the file a name.  

Choose whether you want to export the test results of All Clients, or of a specific group of 
population by Using Query. If you choose to use the query, select an existing query from the 
drop-down box, or click  to create a query. For instructions on creating the query, see Query 
Builder. 

Click Next.  The number of assessments exported will be given. Click OK to close the form.  

Importance of Body Composition 

Body composition refers to the lean body weight plus the fat weight, which together make up the 
total body weight.  The measurement of body composition is important, as obesity is a known 
health hazard.   

Obesity is related to a higher incidence of numerous diseases, including coronary heart disease, 
diabetes, cirrhosis of the liver, hernia, and intestinal obstruction.  Obesity is also of considerable 
concern from an aesthetic standpoint and may be one of the primary reasons an individual 
decides to begin an exercise program.  Therefore, it is important to be able to identify an 
individual's initial body composition before exercising and also to quantify any change that may 
occur with exercising and/or diet.  A desirable weight should be determined for the individual, but 
reducing weight alone should not be the only goal.  

Extremely low body fat can have a negative effect on the body also, which can impair health 
status or alter normal physiological functions.  The body requires an essential percentage of body 
fat to function properly. The lower limit of essential body fat for males is approximately 3% and for 
females it is approximately 12%.  Encroachment into this essential body fat reserve may impair 
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optimal health and capacity for vigorous exercise. In addition, it is recommended that some 
females (those that have low body fat induced irregular menstrual cycles) maintain a critical body 
fat level of at least 17% to maintain normal menstrual cycles. 

Major Symptoms or Signs of Heart Disease 

• Pain, discomfort (or other anginal equivalent) in the chest, neck, jaw, arms, or other areas that 
may be ischemic in nature. 

• Shortness of breath at rest or with mild exercise 

• Dizziness or syncope 

• Orthopnea or paroxysmal nocturnal dyspnea 

• Ankle edema 

• Palpitation or tachycardia 

• Intermittent claudication 

• Known heart murmur 

• Unusual fatigue or shortness of breath with usual activities 

Max Push Up 

In max push up test the client repeats as many push-ups as she/he can. 

Click on Max Push-Up link from the Strength & Flexibility section of Fitness Assessments to 
view the instructions for performing the test. 
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After reading the instructions, click Continue. The following screen appears:  
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When the client is ready to begin the test, click Start.  

To count the number of full repetitions, click an alphanumeric key on the keyboard each time a 
repetition is completed.   

Click OK to save the data and return to the main screen.  

Medical History 

Click on Medical History link from the Biometrics section of Fitness Assessments to bring up 
the medical history questionnaire.   
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Entering medical history information is easy. When the medical history screen appears, the 
cursor will be positioned on the response line for the first question. Begin typing the client's 
response to this question. To move to the response line for the second question and so on, either 
press the enter key, the tab key or use the mouse to position the cursor where you want it and 
click. 

Click Print to print the medical history. The printed version of the medical history has the name, 
date and a line for the client to sign.  

Click OK to exit and save the data.   

Importance of Medical History 

The Medical History questionnaire is designed to identify if the client has any pre-existing injuries 
or ailments that should be brought to the attention of the tester.  It is also used to identify if the 
client is taking medications such as beta-blockers, vasodilators or diuretics that may affect the 
normal physiologic responses during exercise.  It is recommended that the dosage of medication 
is recorded along with a physician's contact number. The medical history provides important 
information to assist the tester and safeguard the client during testing. 

Follow your countries guidelines for exercising with certain diseases or conditions.  

162 



Polar BodyAge System SW Help 

 

One Mile Walk 

One Mile Walk test is designed for men and women 20-69 years of age. The client walks 1.0 mile 
as quickly as possible and takes his/her heart rate immediately at the end of the test by counting 
the pulse for 15 seconds. The walking course should be a measured mile that is flat and 
uninterrupted.  Most individuals can walk a mile in 12-17 minutes. The required information in this 
test is post-exercise heart rate and one mile time (min:sec). 

Click on One Mile Walk link from the Cardiovascular section of Fitness Assessments to view 
the screen for entering the client's test result. The test's input box will appear. 

 

Enter the required information and press OK to save. 

Other Programs settings 

Select System Settings > Test Environment. Select Other Programs from the Test 
Environment Settings view. 
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Check the box next to a program template that you want to include in  Other Programs. Click OK 
to save. 

 

OwnIndex 

About OwnIndex® 

OwnIndex is a score that is comparable to V02max, a commonly used descriptor of aerobic fitness. 
OwnIndex is the result of the Polar Fitness Test, which is an easy, safe and quick way to estimate 
maximal aerobic power. The OwnIndex is based on heart rate, heart rate variability at rest, body 
structure and self-assessed physical activity.  

To follow a client's fitness progress with OwnIndex, start with an initial reading and check the 
value every month. It takes a minimum of six weeks of regular training to see a noticeable 
change. Less fit individuals see progress more rapidly than more active individuals.   

To get reliable test results, take into account the following basic requirements:  

• Client should be relaxed and calm 

• The testing environment should be peaceful.  No disturbing noises (e.g. television, radio or 
telephone), no other people talking to the client. 

• Keep the testing place, time of day and environment the same every time the test is repeated.   
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• Tell your client to avoid eating a heavy meal or smoking 2-3 hours prior to testing. 

• Tell your client to avoid heavy physical effort, alcoholic beverages or pharmacological stimulants 
on the test day and the day before. 

• Allow the client to sit/lay down for 1-3 minutes prior to test, so they can relax their muscles and 
mind. 

Carrying out the OwnIndex®  Test 

After creating a new record or opening an existing record for a client, their height and weight must 
be recorded before the OwnIndex test can be performed. For instructions, see Height/Weight. 

Click on OwnIndex link from the Cardiovascular section of Fitness Assessments to bring up 
the OwnIndex test screen.  

 

1. Select Activity Level from the drop-down box on the upper left corner. 

OwnIndex Activity Classifications 
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Assess the client's long-term physical activity level based on  regular exercise habits 
during six months.   

Low: Exercise is not a regular part of client's life.  He/she walks only for pleasure or 
occasionally exercises sufficiently to cause heavy breathing or perspiration.   

Moderate: The client participates regularly in recreational sports.  For example, he/she 
runs 5 miles/ 8km a week or spends 30-60 minutes a week in comparable physical activity. 
 Or, his/her work requires modest physical activity.   

High: Exercise is an inseparable part of the client's life.  He/she exercises regularly at 
least 3 times a week with heavy paced intensity.  Exercise causes clear breathlessness 
and sweating. For example, he/she runs regularly more than 5 miles/ 8 km a week or 
spend more than 1.5-2 hours in comparable physical activity. 

Top: The client participates regularly in heavy physical exercise at least 5 times a week 
(i.e. he/she exercises to improve performance for competitive purposes).  

2. Verify that the heart rate is being transmitted correctly by looking at value next to the line graph 
on the top.  

3. Click Start to start the test.  When it is finished (~1-5 min.), a VO2max value will be displayed in 
the lower left corner.   

4. Click OK to save the value and return to the main screen.   

Technical Notes for the OwnIndex®  Test 

• The test lasts for 5 minutes 

• The test is based on R-R values that are collected via the heart rate receiver 

• The ticks on the progress bar indicate real time collection of R-R values  

• If a minimum number of R-R values are not collected within the first two minutes, then the test 
will end with a message telling you to check the heart rate cable and try again 

 

OwnZone 

An OwnZone Test is able to determine the individual training heart rate zone.  This training zone 
is called your OwnZone. It guides you through an appropriate warm-up routine and automatically 
determines a safe and effective exercise heart rate zone - your OwnZone - while taking into 
account your current physical condition. 
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For most adults, OwnZone corresponds to 65-85% of the maximum heart rate. OwnZone is 
suitable for cardiovascular training either for health-related or fitness improvement purposes.  

OwnZone works well for those whose goal is weight control via physical activity and training, 
because the OwnZone corresponds to intensity from "light to moderate" to "moderate".  Training 
at this intensity level can be conducted even for extended periods safely and often yields the best 
results for weight loss.   

The OwnZone protocol uses your estimated VO2max to calculate the watts for each minute of the 
test.  If the client already has a VO2max  score from one of the cardiovascular tests in the BodyAge 
System, then that VO2max  score is used.  If the client does not have VO2max  estimated, a physical 
activity questionnaire appears and the a non-exercise VO2max  score will be estimated based on 
age, gender, weight and activity level. 

How to Use OwnZone 

If you have connected a compatible ergometer to the BodyAge System, go to System Settings > 
Test Environment > Cardiovascular, and select the cardio device that you are using for this test 
as well as the serial port that it is connected to. See Cardiovascular Settings for more information. 
  

After creating a new record or opening an existing record for a client, their height and weight must 
be recorded before the OwnZone test can be performed. For instructions, see Height/Weight. 

Click on OwnZone link from the Biometrics section of Fitness Assessments to bring up the 
OwnZone test screen.  

1. If the client has not taken a VO2max test on the BodyAge System, clicking on the OwnZone 
button will bring up the Physical Activity Rating Questionnaire box. Select the choice that best 
represents the client. Click Next. 
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2. Verify heart rate and RPM (Revolutions Per Minute). The heart rate of the client should appear 
in the top box. Instruct the client to begin pedaling.  The RPM’s will show up in the lower box 
(they will only appear if the cardio device is connected to the BodyAge system). Next will become 
activated when a heart rate is transmitted. Click Next.  
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3. The test will begin. Instruct the client to maintain the RPM’s between 60 and 80. Verify that the 
heart rate is being transmitted correctly by looking at value next to the line graph on the top.  

4. Click Start to start the test. To cancel the test and to return to the main screen, click Cancel. 
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The test follows a protocol where the watts are set to a percentage of the client's estimated 
VO2max, but the watts can be adjusted.  If you are using a cardio device that is not connected to the 
BodyAge system, you will have to manually set the watts on the cardio device that you are using 
to match the test screen in order to get accurate results.   

When the test is completed (~1-6 minutes), the data will be displayed.  

Select Print to print the data and the graph. 

Select OK to save the data and return to the main screen.  

 

PAR-Q 

Physical Activity Readiness Questionnaire (PAR-Q) 

The PAR-Q (Physical Activity Readiness Questionnaire) was developed by the British Columbia 
Department of Health. Its purpose is to identify the small number of individuals for whom physical 
activity might be inappropriate. All individuals should answer the questions on the PAR-Q prior to 
testing. 
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Click on PAR-Q link from the Biometrics section of Fitness Assessments to bring up the 
complete PAR-Q questionnaire.  

 

To record the client's answer to each of the PAR-Q questions, use the mouse to point and click 
on the appropriate answer (Yes or No) for each question.   

Click Print to print the completed PAR-Q. The printed version of the PAR-Q has the name, date 
and a line for the client to sign.  

Click OK to exit and save the data.   

After clicking OK, a check mark will appear in the box next to PAR-Q on the Biometrics screen. 
 It will be green if the client answered No to all the questions and red if the client answered Yes to 
any of the questions.  

 Physical Activity Plan 

If the client answers Yes to one or more questions the Results button will be red.  Advise the 
client to talk with the doctor by phone or in person before starting becoming more physically 
active or before they have a fitness appraisal. Have them tell their doctor about the PAR-Q and 
which questions they answered Yes to. 
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If the client answered No honestly to all PAR-Q questions, the Results button will be green and 
you can be reasonably sure that the client can: 

• Start becoming much more physically active - begin slowly and build up gradually.  This 
is the safest and easiest way to go. 

• Take part in a fitness appraisal - this is an excellent way to determine the client's basic 
fitness so that the client can plan the best way for them to live actively. 

• Note:  If the client's health changes so that they answer Yes to any of the questions, 
have them tell their health professional.   

DELAY THE CLIENT BECOMING MUCH MORE ACTIVE: 

•  If the client is not feeling well because of a temporary illness such as a cold or a fever - 
wait until they feel better; or  

•  If the client is or may be pregnant – have them talk to their doctor before they start 
becoming more active. 

 

Polar Energy Pointer Program 

A Polar Energy Pointer Program can be created for the following training computers: FT40, FT7. 

Select the start date and the number 
of weeks that the program will last.  

Enter the following information: 

• The number of days per 
week that the client will be 
exercising (the 
recommended amount of 
days is given based on the 
VO2max score).  

• The sports that the client will 
be doing while exercising.  

• All the other information can 
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be adjusted as well. 

 

Adjust the program targets to fit 
client's training targets: 

• Define intensity zones 
according to training targets 
 (click the field to activate the 
text screen).  

• Sessions can be re-named. 

You can view and print the Energy 
Pointer Program by clicking on 
Program Report. 

 

 

Note: You can download the training files from the client's training computer to create a training 
progress report. See Training Progress for instructions on downloading training files.  

Polar Keeps U Fit Program 

A Polar Keeps U Fit Program can be created for the following training computers: F4, F6/F7, F11, 
F55. 

Select the start date 
and the number of 
weeks that the 
program will last 
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Enter the following 
information: 

The goal of the 
program (Maintain, 
Improve, or 
Maximize fitness 
level). 

• MAXIMIZE: 
the Client 
has been 
exercising 
regularly for 
at least 10-
12 weeks 
and is able 
to train 
nearly every 
day. The 
program 
recommends 
about 5 
h/week in 4-
6 sessions. 

• IMPROVE: 
You are able 
to exercise 
regularly. 
The program 
recommends 
about 3 
h/week, in 3-
5 sessions. 

• MAINTAIN: 
If the client 
has not 
exercised 
recently, this 
is a good 
place to 
start. The 

 

 

 

 

174 



Polar BodyAge System SW Help 

program 
recommends 
about 1½ 
h/week in 2-
3 sessions. 

The number of days 
per week that the 
client will be 
exercising (the 
recommended 
amount of days is 
given based on the 
VO2max score and 
the Client's goal).  

The sports that the 
client will be doing 
while exercising.  

 

The program targets 
are adjusted 
according to the 
above information. 
The following 
information is shown: 

• Weekly 
exercises 
and the time 
that should 
be spent in 
each 
exercise 
intensity 
zone.  

• Total 
exercise 
duration 

• Total 
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calories to 
expend 

For example, the 
total exercise 
duration of Short1 is 
45 minutes, from 
which 30 minutes 
should be spent in 
moderate, and 15 
minutes in Hard 
heart rate intensity 
zone. The number of 
calories to expend is 
550 kcal. 

You can view and 
print a detailed 
Keeps U Fit Program 
by clicking on 
Program Report. 

Click Send to 
Training Computer 
to upload the 
following data to the 
client's training 
computer: User 
Information, Heart 
Rate Limits, 
Cardiovascular 
Program, and 
Time/Date. 

Note: You can download the training files from the client's training computer to create a training 
progress report. See Training Progress for instructions on downloading training files.  

See About the Polar Keeps U Fit Cardiovascular Program for general information on the Polar 
Keeps U Fit Program. 

Polar STAR Training Program 

A Polar STAR Training Program can be created for the following training computers: FT60, FT80. 
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Select the start date and 
the number of weeks that 
the program will last.  

 

The following information is 
needed to create a Polar 
STAR Training Program: 
OwnIndex/VO2max, Sitting 
heart rate, HRmax and the 
goal of the cardiovascular 
program. If these values 
are not available for the 
client, you can manually 
enter the values here.  

Goal options: 

• Improve: if the 
client's target is to 
improve their 
current 
cardiovascular 
fitness level and 
they are able to 
train regularly. 

• Maximize: if the 
client's target is to 
maximize their 
current 
cardiovascular 
fitness level, and if 
they have been 
training regularly 
for at least 10-12 
weeks and training 
nearly every day is 
not a problem for 
them. 

• Weight: if the 
client's target is to 
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lose some weight. 

To transfer the above 
information to the client's 
training computer, place 
the training computer on 
the FlowLink and click on 
Send to Training 
Computer... After placing 
the training computer on 
the flowlink, a message 
appears on the screen to 
inform that the client's 
program is being updated. 

Once the transfer is 
complete, the client's 
STAR Training Program 
appears on the screen. 
The following information is 
shown: 

• Target exercise 
time in three 
different heart rate 
zones (intensity 
targets) 

• Total exercise 
duration 

• Total calories to 
expend 

You can print the STAR 
Training Program by 
clicking on Program 
Report. 

 

 

 

 

 

Note: You can download the training files from the client's training computer to create a training 
progress report. See Training Progress for instructions on downloading training files.  
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Query Builder 

Query Builder is a feature that provides you with the flexibility to create specific groups of your 
clients, which you can utilize in group reports, batch report and client lists. A group can consist of 
nearly any combination of criteria you wish to specify. For example, you can choose all clients 
whose weight is more than 250 pounds and/or whose blood pressure is less than 120/80.   

1. To enter the query builder, click on the  button next to the query field within the Group 
Reports, Batch Report or Client List windows. The following window appears: 

 

2. To build a new query, click New. Enter a name for the query and click OK. The following 
window appears: 
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3. Start creating a criteria for you query by clicking the link Click here to add a new condition.  

4. Click on Select Item to select New Condition or a New set of Conditions. 

 

A condition is a filter or set of filters used to create a desired group of clients. You must have a 
minimum of one condition.  However, the total number of conditions is unlimited.   

Sit and Reach 
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The BodyAge System provides the unique On-Line Modified Sit & Reach testing unit.  The handle 
is attached to a measuring gauge that will record the distance moved and will be automatically 
saved by the computer. 

The tester can choose to record the results of the sit & reach manually (where the tester manually 
measures the modified sit & reach and then enters the results into the text field on the main 
screen) or on-line (which means the sit & reach results are read directly into the computer).   

Before starting this test, be sure the individual has had a proper warm-up and stretched prior to 
the first trial. 

NOTE: Have the client pull and release the cable slowly. Fast motion can damage the measuring 
gauge. 

How to Use the Sit & Reach Test 

Click on Sit & Reach link from the Strength & Flexibility section of Fitness Assessments to 
bring up the on-line sit & reach test screen:  
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1. Once the client is in a start position with the handle held snugly, click Continue. The following 
screen appears: 

 

2. Click Start Trial 1 to begin the test. Instruct the client to move forward slowly. The blue line 
graph, in the lower portion of the protocol screen, will graph the client's sit & reach movement. 
 The client needs to hold the final position for two seconds. Ensure that the client's grip on the 
handle does not changed through the course of the extension. After the test is completed, the 
results will be automatically displayed as a blue bar graph at the bottom of the screen. 

3. After reviewing the result, you can choose to re-measure the client on the sit & reach. Point 
and click Start Trial 2 and follow the exact instructions as above. If you re-measure, the result of 
the furthest sit & reach measurement will be recorded.   

4. Click OK to save the data and to return to the main screen. 

Treadmill 

How to Take a Treadmill VO2max Test 
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After creating a new record or opening an existing record for a client, their height and weight must 
be recorded before the VO2max test can be performed. 

1. Click on the link of the chosen treadmill VO2max test from the Cardiovascular section of Fitness 
Assessments. 

 

2.  The VO2max test screen appears. Verify that the heart rate is being transmitted correctly by 
looking at value next to the line graph on the top.  
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3. Click on Start to activate the test.  A Physical Activity Rating Questionnaire appears.  

184 



Polar BodyAge System SW Help 

 

4. Select the alternative that best represents the person taking the test. Click Next. 
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5. The heart rate of the client should appear in the top box. Instruct the client to begin running. 
Next will become activated when a heart rate is transmitted.  Click Next to begin the test. When 
the test is complete, the data will be displayed.  

6. Select Print to print the data and the graph. Select OK to save the data and return to the main 
screen. 

About the Balke Treadmill Protocol Submax Test 

The Balke protocol maintains 3.3 mph throughout the entire test.  Grade starts at 1% and 
increases by 1% every minute. 

About the Bruce Treadmill Submax Test 

A sub-maximal test takes between 6-12 minutes depending on the client’s fitness level. The test 
involves a change in speed and grade every three minutes, so the incremental increases of 
exercise intensity are relatively large for each stage (2 to 3 METs). 
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Stage MPH Grade Min. MET(M)  MET(W) 

1 1.7 10% 1 

2 

3 

3.2 

4.0 

4.9 

3.1 

3.9 

4.7 

2 2.5 12% 4 

5 

6 

5.7 

6.6 

7.4 

5.4 

6.2 

7.0 

3 3.4 14% 7 

8 

9 

8.3 

9.1 

10.0 

8.0 

8.6 

9.4 

4 4.2 16% 10 

11 

12 

10.7 

11.6 

12.5 

10.1 

10.9 

11.7 

5 5.0 18% 13 

14 

15 

13.3 

14.1 

15.0 

12.5 

13.2 

14.1 

About the Modified Bruce Treadmill Submax Test 

A sub-maximal test takes between 6-18 minutes depending on the client’s fitness level.  The test 
involves a change in speed and grade every three minutes, so the incremental increases of 
exercise intensity are relatively large for each stage (2 to 3 METs). 
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Stage MPH Grade  Minutes 

1 1.7 0 3 

2 1.7 5 3 

3 1.7 10 3 

4 2.5 12 3 

5 3.4 14 3 

6 4.2 16 3 

7 5.0 18 3 

8 5.5 20 3 

   

 

Wall Sit 

The Wall Sit test measures the isometric muscle contractions of the lower body. It presents a 
strength measurement of the lower body.  

Wall Sit Test 

• The client assumes a position with his/her back up against the wall 

• Feet are 12 inches (30.48cm) apart 

• The knees and hips are both bent at a 90 degree angle 
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• Back is straight 

• The arms are relaxed at the sides of the body  

• The subject is asked to hold this position as long as possible and time is measured in 
seconds 

• Timing should be stopped when any deviation in above position occurs during the test 

Using the Wall Sit Test 

Click on Wall Sit link from the Strength & Flexibility section of Fitness Assessments to bring 
up the wall sit test screen. 

You will be given a set of instructions.  

 

After reading the instructions, click Continue. The following window appears: 
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1. When the client is ready to begin the test, click Start and the timer will start to count the time.   

2. When the client is performing the wall sit test encourage him/her to sit as long as they can. 

3. When the client moves from the correct position, click Stop. 

4. Click OK to save the data and return to the main screen.  
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